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A~ WARNING ¥

Thank you for purchasing automation equipment from Automationdirect.com®, doing business as,
AutomationDirect. We want your new automation equipment to operate safely. Anyone who installs
or uses this equipment should read this publication (and any other relevant publications) before
installing or operating the equipment.

To minimize the risk of potential safety problems, you should follow all applicable local and national
codes that regulate the installation and operation of your equipment. These codes vary from area

to area and usually change with time. It is your responsibility to determine which codes should be
followed, and to verify that the equipment, installation, and operation is in compliance with the latest
revision of these codes.

At a minimum, you should follow all applicable sections of the National Fire Code, National Electrical
Code, and the codes of the National Electrical Manufacturer's Association (NEMA). There may be local
regulatory or government offices that can also help determine which codes and standards are necessary
for safe installation and operation.

Equipment damage or serious injury to personnel can result from the failure to follow all applicable
codes and standards. We do not guarantee the products described in this publication are suitable for
your particular application, nor do we assume any responsibility for your product design, installation, or
operation.

Our products are not fault-tolerant and are not designed, manufactured or intended for use or resale
as on-line control equipment in hazardous environments requiring fail-safe performance, such as in the
operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life
support machines, or weapons systems, in which the failure of the product could lead directly to death,
personal injury, or severe physical or environmental damage (“High Risk Activities”). AutomationDirect
specifically disclaims any expressed or implied warranty of fitness for High Risk Activities.

For additional warranty and safety information, see the Terms and Conditions section of our catalog.
If you have any questions concerning the installation or operation of this equipment, or if you need
additional information, please call us at 770-844-4200.

This publication is based on information that was available at the time it was printed. At
AutomationDirect we constantly strive to improve our products and services, so we reserve the right
to make changes to the products and/or publications at any time without notice and without any
obligation. This publication may also discuss features that may not be available in certain revisions of
the product.

This publication may contain references to products produced and/or offered by other companies. The product and company names
may be trademarked and are the sole property of their respective owners. AutomationDirect disclaims any proprietary interest in the
marks and names of others.
Copyright 2024, Automationdirect.com® Incorporated
All Rights Reserved
No part of this manual shall be copied, reproduced, or transmitted in any way without the prior, written consent of Automationdirect.
com® Incorporated. AutomationDirect retains the exclusive rights to all information included in this document.



»~ ADVERTENCIA ¥

Gracias por comprar equipo de automatizacion de Automationdirect.com®. Deseamos que su nuevo
equipo de automatizacion opere de manera segura. Cualquier persona que instale o use este equipo
debe leer esta publicacion (y cualquier otra publicacidn pertinente) antes de instalar u operar el
equipo.

Para reducir al minimo el riesgo debido a problemas de seguridad, debe seguir todos los codigos

de seguridad locales o nacionales aplicables que regulan la instalacion y operacién de su equipo.
Estos codigos varian de area en area y usualmente cambian con el tiempo. Es su responsabilidad
determinar cuales codigos deben ser seguidos y verificar que el equipo, instalacién y operacion estén
en cumplimiento con la revision mas reciente de estos cédigos.

Como minimo, debe seguir las secciones aplicables del Cédigo Nacional de Incendio, Cédigo Nacional
Eléctrico, y los codigos de (NEMA) la Asociacion Nacional de Fabricantes Eléctricos de USA. Puede
haber oficinas de normas locales o del gobierno que pueden ayudar a determinar cuales cédigos y
normas son necesarios para una instalaciéon y operacion segura.

Si no se siguen todos los cédigos y normas aplicables, puede resultar en dafios al equipo o lesiones
serias a personas. No garantizamos los productos descritos en esta publicacién para ser adecuados
para su aplicacion en particular, ni asumimos ninguna responsabilidad por el disefio de su producto,
la instalacién u operacion.

Nuestros productos no son tolerantes a fallas y no han sido disefiados, fabricados o intencionados
para uso o reventa como equipo de control en linea en ambientes peligrosos que requieren una
ejecucion sin fallas, tales como operacién en instalaciones nucleares, sistemas de navegacion aérea, o
de comunicacién, control de tréfico aéreo, maquinas de soporte de vida o sistemas de armamentos
en las cuales la falla del producto puede resultar directamente en muerte, heridas personales, o dafios
fisicos o ambientales severos (“Actividades de Alto Riesgo”). Automationdirect.com especificamente
rechaza cualquier garantia ya sea expresada o implicada para actividades de alto riesgo.

Para informacion adicional acerca de garantia e informacién de seguridad, vea la seccion de Términos
y Condiciones de nuestro catalogo. Sitiene alguna pregunta sobre instalacion u operacién de este
equipo, o si necesita informacion adicional, por favor lldmenos al ndmero 770-844-4200 en Estados
Unidos.

Esta publicacion esta basada en la informacién disponible al momento de impresién. En
Automationdirect.com nos esforzamos constantemente para mejorar nuestros productos y servicios,
asi que nos reservamos el derecho de hacer cambios al producto y/o a las publicaciones en cualquier
momento sin notificacién y sin ninguna obligacion. Esta publicacién también puede discutir
caracteristicas que no estén disponibles en ciertas revisiones del producto.

Marcas Reqgistradas

Esta publicacion puede contener referencias a productos producidos y/u ofrecidos por otras compafiias. Los nombres de las
compafifas y productos pueden tener marcas registradas y son propiedad Unica de sus respectivos duefios. Automationdirect.com,
renuncia cualquier interés propietario en las marcas y nombres de otros.

Propiedad Literaria 2024, Automationdirect.com® Incorporated

Todos los derechos reservados

No se permite copiar, reproducir, o transmitir de ninguna forma ninguna parte de este manual sin previo consentimiento por escrito
de Automationdirect.com® Incorprated. Automationdirect.com retiene los derechos exclusivos a toda la informacién incluida en
este documento. Los usuarios de este equipo pueden copiar este documento solamente para instalar, configurar y mantener el equipo
correspondiente. También las instituciones de ensefianza pueden usar este manual para propositos educativos.



» AVERTISSEMENT »

Nous vous remercions d'avoir acheté I'équipement d’automatisation de Automationdirect.com®,

en faisant des affaires comme, AutomationDirect. Nous tenons a ce que votre nouvel équipement
d'automatisation fonctionne en toute sécurité. Toute personne qui installe ou utilise cet équipement
doit lire la présente publication (et toutes les autres publications pertinentes) avant de I'installer ou de
['utiliser.

Afin de réduire au minimum le risque d'éventuels problemes de sécurité, vous devez respecter

tous les codes locaux et nationaux applicables régissant I'installation et le fonctionnement de votre
équipement. Ces codes différent d’une région a l'autre et, habituellement, évoluent au fil du temps. |l
vous incombe de déterminer les codes a respecter et de vous assurer que I'équipement, l'installation
et le fonctionnement sont conformes aux exigences de la version la plus récente de ces codes.

Vous devez, a tout le moins, respecter toutes les sections applicables du Code national de prévention
des incendies, du Code national de I'électricité et des codes de la National Electrical Manufacturer’s
Association (NEMA). Des organismes de réglementation ou des services gouvernementaux locaux
peuvent également vous aider a déterminer les codes ainsi que les normes a respecter pour assurer
une installation et un fonctionnement sdrs.

L'omission de respecter la totalité des codes et des normes applicables peut entrainer des dommages
a I'équipement ou causer de graves blessures au personnel. Nous ne garantissons pas que les produits
décrits dans cette publication conviennent a votre application particuliere et nous n'assumons aucune
responsabilité a I'égard de la conception, de I'installation ou du fonctionnement de votre produit.

Nos produits ne sont pas insensibles aux défaillances et ne sont ni concus ni fabriqués pour
I'utilisation ou la revente en tant qu'équipement de commande en ligne dans des environnements
dangereux nécessitant une sécurité absolue, par exemple, I'exploitation d'installations nucléaires,

les systémes de navigation aérienne ou de communication, le contréle de la circulation aérienne,

les équipements de survie ou les systemes d'armes, pour lesquels la défaillance du produit peut
provoquer la mort, des blessures corporelles ou de graves dommages matériels ou environnementaux
(«activités a risque élevé»). La société AutomationDirect nie toute garantie expresse ou implicite
d'aptitude a I'emploi en ce qui a trait aux activités a risque élevé.

Pour des renseignements additionnels touchant la garantie et la sécurité, veuillez consulter la section
Modalités et conditions de notre documentation. Si vous avez des questions au sujet de l'installation
ou du fonctionnement de cet équipement, ou encore si vous avez besoin de renseignements
supplémentaires, n'hésitez pas a nous téléphoner au 770-844-4200.

Cette publication s'appuie sur I'information qui était disponible au moment de I'impression. A la
société AutomationDirect, nous nous effor¢cons constamment d’améliorer nos produits et services.
C’est pourquoi nous nous réservons le droit d'apporter des modifications aux produits ou aux
publications en tout temps, sans préavis ni quelque obligation que ce soit. La présente publication
peut aussi porter sur des caractéristiques susceptibles de ne pas étre offertes dans certaines versions
révisées du produit.

Marques de commerce

La présente publication peut contenir des références a des produits fabriqués ou offerts par d'autres entreprises. Les désignations des
produits et des entreprises peuvent étre des marques de commerce et appartiennent exclusivement a leurs propriétaires respectifs.
AutomationDirect nie tout intérét dans les autres marques et désignations.

Copyright 2024, Automationdirect.com® Incorporated

Tous droits réservés

Nulle partie de ce manuel ne doit étre copiée, reproduite ou transmise de quelque facon que ce soit sans le consentement préalable
écrit de la société Automationdirect.com® Incorporated. AutomationDirect conserve les droits exclusifs a I'égard de tous les
renseignements contenus dans le présent document.
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INTRODUCTION

In This Chapter...
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NOTE: Think & Do software (PC-TD8-USB & PC-TD8-WEB4-USB) has been retired and is no longer supported. Please consider updating to Do-more
software for your project.




- Chapter 1: Introduction

Introduction

Purpose of this Manual
This manual describes how to use the Ethernet Remote Master (ERM) Modules. You will find
information about:

«  Configuring the ERM module
¢ Network layouts and cabling
+  Maintenance and troubleshooting

Other Reference Materials
«  Do-more! User Manual, part number H2-DM-M
e DL205 User Manual, part number D2-USER-M
«  DL405 User Manual, part number D4-USER-M
«  Ethernet Base Controller Manual (DL205/DL405), part number H24-EBC-M
e Terminator I/O Ethernet Base Controller User Manual, part number TTH-EBC-M
«  Terminator I/O Installation and 1/O User Manual, part number T1K-INST-M
¢ WIinPLC User Manual, part number H2-WPLC-M

Who Should Read this Manual
If you need a high-speed Ethernet remote I/O communications link between a DirectLogic
PLC or WinPLC local base and remote Ethernet slaves and you understand the basics of
installing and programming PLCs, this is the right manual for you. This manual provides the
information needed to setup and configure the ERM module and its Ethernet slaves.

Technical Support
We strive to make our manuals the best in the industry. We rely on your feedback to let
us know if we are reaching our goal. If you cannot find the solution to your particular
application, or, if for any reason you need technical assistance, please call us at:

770-844-4200

Our technical support group will work with you to answer your questions. They are
available Monday through Friday from 9:00 A.M. to 6:00 P.M. Eastern Time. We also
encourage you to visit our web site where you can find technical and non-technical
information about our products and our company.

http:/lwww.automationdirect.com
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Conventions Used

— NOTE: When you see the “note pad” icon in the left-hand margin, the paragraph to its inmediate
‘ right will be a special note. Notes represent information that may make your work quicker or
more efficient. The word NOTE: in boldface will mark the beginning of the text.

When you see the “exclamation point” icon in the left-hand margin, the paragraph to its
immediate right will be a warning. This information could prevent injury, loss of property,

& or even death in extreme cases. Any warning in this manual should be regarded as critical
information that should be read in its entirety. The word WARNING in boldface will mark the
beginning of the text.

APTER
INTRODUCTION
Key Topics for Each Chapter
The beginning of each chapter will list the _
key topics that can be found in that chapter. e -

& ions Used. -3

Ethernet Remote Master (ERM) 1-4
How the PLC CPU Updates Remote 1/0 POINtS..........cmmmmrmmmmisssssmsssssssssssssssssssssssssssssses 1=
Frequently Asked Questi 1-8

L o o o AV Y o o SV S SV N & & &X &% &
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Ethernet Remote Master (ERM)

The Ethernet Remote Master (ERM) module provides a low-cost, high-speed Ethernet
Remote I/O link for DirectLogic 205/405, Do-more! PLC systems, and WinPLC systems.
The ERM connects the local CPU base(s) to the Ethernet remote slave modules via a
10/100BaseT (twisted pair, copper wire) or 10BaseFL (fiber optic) Ethernet link. Each ERM
module can support up to sixteen slaves when used in DirectLogic 205/405 or Do-more!
PLC systems. When used in Think & Do WinPLC systems, a limitation of one ERM with one
slave applies per system.

Ethernet

H2-ERM(100) H4-ERM(100) H4-ERM-F

Note: The H2-ERM module was
discontinued in 2014 but is still
covered in this manual.

Remote Slaves

The following Ethernet Base Controller (EBC) slave modules and Ethernet Interfaces for
AC Drives are supported by the ERM module. The remote I/O network may consist of

a combination of these slaves. The ERM module can support up to sixteen slaves when
used in DirectLogic 205/405 or Do-more! PLC systems. When used in Think & Do WinPLC
systems, the ERM module is limited to supporting one slave.

The EBC slave updates all of its I/O data (including analog 1/0) internally at a high rate that
is independent of the rate that the ERM may poll the EBC for its I/O data. This allows the

ERM to read the most current I/0 data regardless of PLC scan times or other slave I/O cycle
times.

GS-EDRV*

H2-EBC (100, -F) T1H-EBC(100) H4-EBC (-F)

GS-EDRV100*

*For use with AC Drives

1 4 I Ethernet Remote Master User Manual, 2nd Edition, Rev. D - H24-ERM-M
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Configuring the Ethernet Remote 1/0O Network

AN

Use a PC equipped with a 10/100BaseT or 10BaseFL network adapter card and the Ethernet
Remote Master (ERM) Workbench software configuration utility that comes with this
manual to configure the ERM module and its slaves over the Ethernet remote 1/O network.

Warning: We recommend using a dedicated Ethernet remote 1/O network for the ERM and
its slaves. While Ethernet networks can handle a very large number of data transmissions,
and normally handle them very quickly, heavy Ethernet traffic can adversely affect the
reliability of the slave I/0 and the speed of the network.

Running the Ethernet Remote I/O Network

Once the ERM /O network is configured and running, the PC can be removed from the
network.

PC running ERM Workbench to
configure the ERM network

DirectLogic or
Do-more! PLC

Dedicated ERM Module
Hub(s) for ERM
Network
\ [ DL205 1/0
“
GS-EDRY, i
GS-EDRV100 ~ DL405 1/0
)
AC Drive il Terminator 1/0

Ethernet Remote Master User Manual, 2nd Edition, Rev. D - H24-ERM-M I 1_5
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ERM / ECOM Systems
Keep ERM networks, multiple ERM networks and ECOM / office networks isolated from
one another as shown below. Do not attempt to connect an ECOM module or non ERM
Workbench PC to a hub that the dedicated ERM network is using. Having an ECOM
module(s) on an ERM Ethernet network can adversely affect the reliability and the speed of
the ERM slave 1/0.

PC for HMI,
Dedicated ERM SCADA, etc.
Network .
1
ECOM or
Dedicated Office Network
Hub(s) for ERM
GS-EDRV Network

AC Drive

PC for Data Acquisition,
MES, ERP or other
business systems
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How the PLC CPU Updates Remote I/0 Points

The PLC CPU, ERM and Remote Slave (EBC) modules work together to update the remote
I/O points. There are three asynchronous scan cycles working together to transfer the
remote I/O data between the PLC and the I/0 modules: the EBC scan, the ERM scan and
the PLC scan. These are described below.

During each PLC CPU scan, the ERM is allowed one access to the PLC's memory. The access
can be a write to the PLC or a read from the PLC, but not both. There are four types of data
that are processed: discrete inputs, discrete outputs, analog inputs and analog outputs.
The ERM can only process one of these four data types on any given scan. If all data types
are used, it will take four PLC scans to completely update all of the remote 1/O points. The
largest amount of data that the PLC can process in a single request is 128 bytes. If any of
the four 1/0 types exceeds 128 bytes of data, it will take multiple scans to process that
type's data.

It is possible for the PLC's scan to be faster than the ERM's processing scan. This is largely
dependent on the size of the application program, as well as the type and number of
remote |/O points. If there are /O points that must be updated every PLC scan, it is
recommended that those points be placed in the CPU base or local expansion base.

1) PLC CPU Scan: executes program logic and scans local I/0. The PLC User Manual
describes the PLC scan in detail.

2) ERM Scan: there are four /0O types that can be processed by the ERM: discrete inputs,
discrete outputs, analog inputs and analog outputs. It takes a least one for each of the four
I/O types present to complete an ERM scan. The typical ERM cycle is as follows:

PLG Process
Scan
N Read discrete output data from the PLC
Read analog output data from the PLC
IN+1 Write all of the output data to the EBCs
Collect input data from the EBCs
N+2 Write discrete inputs to the PLC
IN+3 Write analog inputs to the PLC

3) Remote Slave Scan (EBC): constantly collects all discrete and analog input data from the
input modules in the base. This keeps the most recent input data available whenever the
ERM requests it. The EBC writes to the output modules as the data is received from the
ERM.

In general, it will take four PLC scans to completely update the remote 1/0O. You can use
the ladder logic example on page B-5 to get the ERM update statistics. This will provide
detailed information about the ERM's processing time.
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Frequently Asked Questions

Q. Which protocols are supported by the ERM module?

A. Aprotocol is a set of rules that allows computers to connect with one another
specifying the format, timing, sequencing, and error checking for data packet
transmission. The ERM module supports Novell IPX and UDP/IP (Universal Datagram
Protocol/Internet Protocol). When configuring the ERM and EBCs, your PC must
support one of these protocols. However, the ERM and slaves can utilize their
own protocol selection regardless of the protocols supported by your PC.

Q. Can | create multiple remote 1/0 networks by putting more than one ERM in a single PLC
/ WinPLC base?

A. Yes, for DirectLogic and Do-more! PLCs, but Think & Do WinPLC systems are
limited to one ERM module with one slave per system to ensure reliable system
performance. If more than one EBC slave is desired in a Think & Do WinPLC
system, please contact Entivity's technical support at 734-205-5000 or e-
mail info@entivity.com. Be sure to consult Chapter 2 for important installation
information, and be sure not to exceed the PLC power budget (see the module
specifications in Appendix A and the PLC User Manual). Also, it is very important
to keep each ERM and its slave(s) isolated from other ERMs and their slaves.

Q. What does it mean to “set up” the ERM module?

A. The ERM module must be configured usin? the Ethernet Remote Master
Workbench to know how many slaves and I/0 points there will be on the remote
/0 network. There are also other advanced ERM settings to configure.

Q. How much remote 1/0 can | have?

A. The ERM module su 8orts up to 16 additional DL205/Do-more! EBC bases,
16 Terminator I/0 EBC systems, 16 fully expanded DL405 EBC systems,
Ethernet Interfaces for AC Drives or any combination of the four. If a
WinPLC is the system interface, the ERM can only support one slave.

Q. Can I reserve slots in a base for future 1/0 expansion?

A. Yes, the "Padding” feature within the Slave Configuration window of the
ERM Workbench allows reserving addresses for future I/0 modules at
the end of each of the EBC slave systems (not between modules).

Q. Can | program or use an operator interface on the EBC slave when used with an ERM?

A. No, the serial port on the EBC slave is not supported at
this time when used with an ERM module.

Q. Which LAN topology should I use?

A. ERM modules are available for connecting to 10/100BaseT or 10BaseFL (fiber
optic) networks. The cable distances and environmental conditions often dictate
which media ty]pe should be used. The most popular and flexible topology currently
is 10/100BaseT, but 10/100BaseT is susceptible to electrical noise and is limited
to relatively short cable runs. On the other hand, it is very simple and inexpensive,
and repeaters can be used to extend its cable length limitations. 10BaseFL
allows much longer cable runs with immunity to electrical noise. The fiber optic
cable and hubs are currently more expensive than those for 10/100BaseT.
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ERM/Remote Slave Network Identifiers

This chapter describes the various network identifiers used by the ERM and its slave
modules. Each module on a network must be uniquely identified. There are three
identifiers that can be used to make a module unique.

The three module identifiers are:
* Module ID

« IP (Internet Protocol) Address (a slave may be used on the
Internet, but I/0 cycle time may be very high)

« Ethernet Address (MAC Address)

The first two are user-selectable. The third one is set at the factory. A Name may be
assigned to a module, but the ERM cannot address a slave by its Name.

The identifiers are used to link the ERM module to its remote slaves The decision
about which type of identifier to use is an important one. Much of the decision
depends on the protocol requirements of your particular application. Ease of
maintenance and troubleshooting also must be considered before deciding which
type to use.

Identifiers Protocol How to Set Format Restrictions/Notes
Module ID can be changed
DIP Switch Slave fumber 163, without NetEdit. Disables Module
ID in NetEdit.
Module ID IPX DIP Switch + be el 10 0
. witch must be set to “0”.
NetEdit Slave Number 1-65535 Must use NetEdit to set Module
Set ERM to 0 D.
4 Three-digit Numbers
. See Your Network Administrator,
IP Address UDP/IP NetEdit XXX XXX XXX XXX Only for UDP/IPAdminst
(See Page 2-4)
Ethernet Address  |IPX Set at Factory 12 Hex digits Factory-assigned

ERM / Slave Configuration Tools

2-2 I

ERM Workbench software utility must be used to configure the ERM and its slave
modules. If either Module ID (set by dip switch) or Ethernet Address is used for
network identification, then ERM Workbench is all that is needed to configure the
network modules. ERM Workbench is described in detail in Chapter 3.

NetEdit software utility will be needed in addition to the ERM Workbench if IP
Addressing (UDP/IP) is necessary or if the Module ID is software set. If the H4—-EBC
slave is used with analog I/O or the high speed counter, NetEdit will be required to
configure the H4-EBC. NetEdit is described in detail in Chapter 4.
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ERM / Slave Module ID

You can assign the Slave Module ID:
« Using the DIP switches on the module (1-63).
« Using the configuration tools in NetEdit that is included
within the ERM Workbench utility (1-65535).

Use the DIP switch if you want the ability to install or change slave modules without
using a PC to set the Module ID. Set the module’s DIP switch, insert the module in
the base, and connect the network cable. Your Module ID is set on powerup, and
your module is ready to communicate on the network.

Ignore these numbers

i

o Do
0 [w

2'5 2'4 2'3 2'2 2'1 2'0
‘(3'2)(1'6)&3) 4) (2)(1)

\
Binary Value

The numbers (0-7) printed
on the circuit board indicate
the power of 2 represented
For ERM100, Dipswitch 6 is Recover - by each slide switch.
Dipswitch is used to reset IP
settings back to factory default
on power-up in case device is
lost on network.

If you prefer to be able to set or change all Module IDs on your network from a
single PC, use the tools in NetEdit. In chapter 4, we step through the use of NetEdit
and the network identifier options.

The Module ID equals the sum of the binary values of the slide switches set in the
ON position. For example, if you set slide switches 1, 2, and 3 to the ON position,
the Module ID will be 14. This is found by adding 8+4+2=14. The maximum value
you can set on the DIP switch is 32+16+8+4+2+1=63. This is achieved by setting
switches 0 through 5 to the ON position.
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IP Address

N

An IP Address can be assigned to the ERM module or its slaves if your network requires
one. Normally, a network administrator will assign an IP Address to each device on the
network. Since it is recommended to use a separate dedicated network for your ERM
, you do not have to use the IP Address, unless you are using the UDP/IP protocol.
Use the Module ID or Ethernet Address for each module when using the IPX protocol.

You can use NetEdit within the ERM Workbench utility to give the ERM or its slave
modules an IP Address. Each ERM and slave must have a unique IP Address.

The module ships from the factory with an IP Address of 255.255.255.255. This is not a
usable IP Address for normal communications. It only serves as a default setting which
can be changed using NetEdit. The valid settings are 0 through 254. You do not have
to change the default IP Address unless you are using IP Address protocol. The default
setting does not cause conflicts with other network communications.

If you change the default IP Address for linking to other network devices, you must
change all four 255" fields. If any field contains the number 255 and other fields
have been changed, the module will not be recognized on the network.

Example

Valid IP Address: 192.168.100.002

Nol! }5{1 68.100.002

WARNING: There cannot be duplicate IP Addresses on your network. If you are using the IP
Address, all modules must have a unique number.

Ethernet Address

A unique Ethernet Address is assigned to each module at the factory and will not
change. It is printed on a label attached to each module. The Ethernet Address is
recognized by ERM Workbench and NetEdit. The Ethernet Address is a twelve digit
number with no deliberate relationship to your network or functional areas of your
plant. It does not usually serve as a convenient and easily remembered identifier for
the module.

Factory-assigned Ethernet Address

Host Auto Prod
H4-ERM
00 E0 62 20 00 85

Host Auto Prod

H2-ERM
00 EO0 62 20 00 84

Using Multiple Network Identifiers

24 |

Using one type of identifier does not limit your use of the other identifier types.
IP addressing, Module ID and Ethernet Addressing may be used on one dedicated
remote 1/O network.
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Inserting the ERM Module in the I/0 Base

DL205/Do-more! Slot Choices

The DL205 and Do-more! systems support placement of the ERM module in the CPU-base
only. It does not support installation of the ERM in local expansion or remote 1/O bases.
The number of usable slots depends on how many slots your base has. See the chart below
for limitations on slot selection. The D2-230 CPU does not support the ERM modules.

Sen

X+ BN

| lot 1] Slot2| Sl lot 4
Slot 0| Slot Slot Slot 3| Slot No!

29
:
:
:
:

[l
]
I D G G A G s S D G O

WARNING: Your system can be damaged if you install or remove system components before
disconnecting the system power. To minimize the risk of equipment damage, electrical shock, or
personal injury, always disconnect the system power before installing or removing any system

component.
Module Type Usable Slots
02240 D2-03B-1, D2-03BDC1-1 7
D2-250-1 D2-04B-1, D2-04BDC 11 12
H2-ERM(100, -F)  |D2-260 D2-06B-1, D2-06BDC1-1, D2-06BDC2-1 12,34
D2-262 D2-09B-1, D2-09BDC1-1, D2-09BDC2-1 12,3,4,56,7
H2-DM1 /H2-DMIE  |Any Base Any Sl

H2-ERM (100, -F) Module Installation

5t | == | ==
205 -, | 884 88 \
o Retaining Clips
/
— — —

To install the ERM module, line up the module’s printed circuit board with the grooves in
the base and push the module until it is flush with face of the base power supply. If you
feel more than moderate resistance when you push the module into the base, the circuit
board may not be aligned with the grooves in the base. When the module is firmly seated
in the slot, depress the top and bottom retaining clips to lock the module in place.

accommodate the added module. See the User Manual for your PLC for more information about

NOTE: When adding modules to your PLC always confirm that your power budget will
calculating the power budget. See Appendix A for the power consumption of the ERM modules.
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DL405 Slot Choices

A\

For PLC systems with D4-430 and D4-440 CPUs, the ERM modules can reside in any 1/0 slot
but only in the CPU-base. The D4-450 and D4-454 CPUs allow the installation of the ERM
module in the CPU-base or in local expansion bases. If the ERM module is used in a local
expansion base, all bases in the system must be the "=1" type bases. The valid part numbers
for these bases are D4-04B-1, D4-06B-1, and D4-08B-1. The "—1" on the end of the part
number indicates that the base supports specialty modules including the ERM. The “-1"
bases can be connected as local expansion bases or remote bases. They are not the same
thing. Remote bases do not support the ERM modules!

8l =
405 O
o ___
CPU
L] Slot 0 Slot 1 Slot 2 Slot 3
oL

WARNING: Your system can be damaged if you install or remove system components before
disconnecting the system power. To minimize the risk of equipment damage, electrical shock, or
personal injury, always disconnect the system power before installing or removing any system

component.
Module Type CPU Base UsablesﬁF:;J-Base Usagiz)éﬁg:ssmn

D4-04B, D4-04B-1 0,1,2,3 N/A

H4-ERM(100, -F) D4-430/D4-440 D4-06B, D4-06B-1 0,1,2,3,4,5 N/A
D4-08B, D4-08B-1 0,1,2,3,4,56,7 N/A
D4-04B 0,1,2,3 N/A
D4-06B 0,1,2,3,45 N/A

H4-ERM(100, -F) D4-450/D4-454 D4-088 01234567 NA
D4-04B-1 0,1,2,3 0,1,2,3
D4-06B-1 0,1,2,3,45 0,1,234,5"
D4-08B-1 0,1,2,3,4,5,6,7 0,1,2,3,456,7*

* You must use the “~1” base for the CPU-base and all local expansion bases.

NOTE: Before installing the ERM module, confirm that your power budget will accommodate the
added module. See the PLC user manual for your PLC for more information about calculating the
power budget. See Appendix A for the power consumption of the ERM modules.
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H4-ERM(100, -F) Module Installation
To insert the ERM module in a DL405 base, place the bottom tab of the module into the
notch at the bottom of the base. Pivot the module toward the base as shown below. Ensure
that each module is tightly seated and secured with the captive screw at the top of the
module.

DL405 Base

Disconnect power before installing module!

Which Modules are Supported in the Ethernet Slaves
The Ethernet remote I/O slaves accept the most commonly used I/O modules for the
DL205/Do-more!, DL405 systems and Terminator I/O systems (AC, DC, AC/DC, Relay an
Analog). The table below lists by category those modules that you may use in a remote 1/0
slave. A few specialty modules that are supported in the slaves are listed below.

Module/Unit Remote Slave Module/Unit Remote Slave
PLC CPUs No H2-CTRIO(2) Yes
DC Input Modules Yes Elzl\ﬁg T No
AC Input Modules Yes H4-CTRIO, D4-HSC Yes
AC/DC Input Modules Yes D2-EM No
DC Output Modules Yes ﬁg&rgﬁ(r,}'fga,t\f; ;ui}nsd No
AC Output Modules Yes
Relay Output Modules Yes
Analog I/0 Modules Yes
Thermocouple Module Yes
RTD Module Yes

NOTE: The User Manual for Analog I/0 Modules discusses scan times for updating analog 1/O data
19999 for modules installed in local bases. Please be aware that the scan times for updating are different
‘ for remote I/O modules installed in remote bases. The CPU scan is asynchronous with the remote
scan by the master module. Thus, an analog input module installed in a remote base, for example,
may not have its data updated by the CPU “once every scan per channel” as stated in the user
manual. The CPU scan may, in fact, cycle several times while the remote scan is taking place. Take
this into account in applications where the timing is critical.
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ERM Network Layouts

Each ERM module can support up to 16 remote slaves (if a WinPLC system is used, only
one slave can be supported by the ERM module). The slaves supported are the H4-EBC(-F),
H2-EBC(-F), TTH-EBC, GS-EDRV100 and HA-EDRV2. A hub or repeater connects multiple
slaves into a star topology. Multiple hubs or repeaters can be used to create a star-
bus-star topology. Once the ERM 1/O network is configured and running, the PC can be
removed from the network.

Configuring the Ethernet Remote 1/0 Network
Use a PC equipped with a 10/100BaseT or 10BaseFL network adapter card and the Ethernet
Remote Master (ERM) Workbench software configuration utility that comes with this

manual

to configure the ERM module and its slaves over the Ethernet remote 1/0 network.

Running the Ethernet Remote 1/0 Network

PC running ERM Workbench to
configure the ERM network

DirectLogic or
Do-more! PLC

Dedicated ERM Module

hub(s) for ERM
Network
\ . DL205 1/0
GS-EDRV, T
GS-EDRV100 == DL405 1/0
i

Terminator 1/0

AC Drive

Once the ERM I/O network is configured and running, the PC can be removed from the

networ

E

k.
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ERM / ECOM Systems

Keep ERM networks, multiple ERM networks and ECOM / office networks isolated from
one another as shown below. Do not attempt to connect an ECOM module or non ERM
Workbench PC to a hub that the dedicated ERM network is using. Having an ECOM
module(s) on an ERM Ethernet network can adversely affect the reliability and the speed of
the ERM slave 1/0.

modules on separate

Keep ERM and ECOM P
Networks ﬁ

l I=
==
- PC for HMI or
| SCADA, etc.

S

Dedicated
ERM Network

ECOM or
Office Network

i e
1 3

qlgllllllll =

ECOM

PC for Data Acquisition
in MES, ERP or other
business systems

Dedicated Hub(s)
for ERM Network

Warning: We recommend using a dedicated Ethernet remote /O network for the ERM and

its slaves. While Ethernet networks can handle a very large number of data transmissions, and
normally handle them very quickly, heavy Ethernet traffic can adversely affect the reliability of the
slave 1/O and the speed of the network.
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Network Cabling

ERM Supports Three Standards
Three types of ERMs are available. The H2-ERM and H4-ERM support the 10BaseT
standard. The H2-ERM100 and H4-ERM100 support the 10/100BaseT standard. The
H2-ERM-F supports the 10BaseFL standard. The 10/100BaseT standard uses twisted pairs of
copper wire conductors, and the 10BaseFL standard is for fiber optic cabling.

10/100BaseT Networks

10/100BaseT
. . 10BaseFL
Unshielded tistes: 62,5/ 125 MMF fiber
pair cable with RJ45 optics cable with ST-

connectors style connectors

The cable used to connect a PLC (or PC) to a hub or repeater is called a patch (straight-
through) cable. The cable used to connect two Ethernet devices (Point-to—Point) together
is a crossover cable. We recommend that you purchase cables pre-assembled with
connectors for convenient and reliable networking.

This diagram illustrates the standard wire positions in the RJ45 connector. We recommend
all ERM 10/100BaseT cables to be Category 5, UTP cable.

Patch (Straight-through) Cable

TD+ 7 LOQRWHT ORMHT 4 —p7
TD- 2 |OR ORI Tp-
RD+ 3 GRNWHT GRNWHT | 5 ppy

4 | BLU BLU| ,

10/100BaseT 5 | BLUWHT BLUWHT |
RD- 6 GRN GRN| ¢ rp_

7 [ BRN/WHT BRN/WHT | -

g | BRN BRN | g
RJ45 RJ45

Crossover Cable
12345678 OR/WHT GRN/WHT
8-pin RJ45 Connector 1T—lE))i ; OR GRN igt ;
(8P8C) RD+ 3 -CRNWHT OR/WHT Rbs 3
2 [BLU BLU 4
5 [ BLUMWHT BLU/\Ng; 5
GRN

RD- (75 BRN/WHT BRNWHT | RP- ‘75
g | BRN BRN 8
RJ45 RJ45
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10/100BaseT

Most 10/100BaseT hubs or repeaters use a patch (straight-through) cable for connecting
the network devices (PLCs or PCs). For hub-to-hub connections a crossover type cable is
commonly required. The figures on the previous page show pin assignments and insulation
color codes for patch (straight-through) and crossover type Ethernet cables.

UTP Cable
The ERM has an eight-pin modular port that accepts RJ45 type connectors. UTP (Unshielded
Twisted-Pair) cable is rated according to its data-carrying ability (bandwidth) and is given
a “category” number. We strongly recommend using a category 5 cable for all ERM
connections.

10BaseFL

Each module has two bayonet ST-style connectors. The ST-style connector uses a quick
release coupling which requires a quarter turn to engage or disengage. The connectors
provide mechanical and optical alignment of fibers. Each cable segment requires two strands
of fiber: one to transmit data and one to receive data. The ST-style connectors are used to
connect the H2-ERM-F or H4-ERM-F module to another H2-ERM-F or H4-ERM-F module
or a fiber optic hub or repeater.

Fiber Optic Cable
The H2-ERM-F and H4-ERM-F modules accept 62.5/125 multimode fiber optic (MMF) cable.
The glass core diameter is 62.5 micrometers and the glass cladding is 125 micrometers. The
fiber optic cable is highly immune to noise and permits communications over much greater
distances than 10/100BaseT.

Fiber Optic Module ST Connector

Multimode Fiber Optic (MMF) Cable Fiber cross-section

Ferrule

N

Transmit Sheathing

Core
Receive

_— i
62.5/125 MMF cable with ]
bayonet ST-style connectors Cladding

Connecting ERM
Transmit to Slave Transmit

C D)
C D)

Receive Receive
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Maximum Cable Length
The maximum distance per 10/100BaseT cable segment is 100 meters or 328 feet.
Repeaters extend the distance. Each cable segment attached to a repeater can be up to 100
meters. Two repeaters connected together extend the total range to 300 meters. For really
long distances, consider using Ethernet/Fiber media converters like the SE-MC2U-ST.

The maximum distance per 10BaseFL cable segment is 2,000 meters or 6,560 feet (1.2

miles). Repeaters extend the distance. Each cable segment attached to a repeater can be
2,000 meters. Two repeaters connected together extend the total range to 6,000 meters.

10/100Base-T Ethernet Control
Network shown (also supports
10Base-FL Networks)

Direct

LOGIC:

100m, max. 100m, max.
(328 ft.) (328 ft.)

10/100Base-T Hub (required )
if using more than one
Ethernet slave)

100m, max. 100m, max.
(328 ft.) 100m, max, (328 ft.)

/ (328 ft.)
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ERM Workbench Software

Ethernet Remote Master (ERM) Workbench is a software utility that must be used to
configure the ERM and its remote Ethernet slaves. The ERM Workbench supports two
methods of configuring the ERM 1/O network. Both methods are explained later in this
chapter.

The two configuration methods are:

«  ERM Workbench PLC Wizard — simplifies the ERM 1/O network configuration
procedure when a PLC is used as the CPU Interface.

*  ERM Workbench - configures an ERM 1/O network whether the CPU Interface is a
PLC or WinPLC, and allows access to all ERM I/O network parameters.

NetEdit, a software utility that can be called from within the ERM Workbench, can
be used to set the Ethernet master/slave Module ID, set an IP address if necessary
or configure DL405 EBCs with analog I/0O modules. Both ERM Workbench

and NetEdit can be used to monitor the remote I/O network and to perform
diagnostic and troubleshooting tasks.

ERM Workbench software is installed as a utility program when you install DirectSOFT or
Do-more! Designer. The latest version of ERM Workbench is also available for download
from Host Engineering'’s web site (www.hosteng.com). ERM Workbench consists of several
files, all of which must be located in the same directory. The installation process places the
files in the C:\HAPTools directory (default). The files may be placed in another directory,
but remember all of the ERM Workbench files must be placed within the same directory.

Launching ERM Workbench

5 DSLaunch

Fi View Help

There are four methods to launch ERM Workbench:

1. Using the Windows Start menu
Programs>AutomationDirect
Tools>ERM Workbench (on right)

2. Launching DirectSOFT, then select
PLC >Tools>ERM Workbench

3. Launching DirectSOFT, then select

Utilities

-~ iga DirectSOFT on the Web
- Applications
@ DirectSOFT 5 Programming

-] visit AutomationDirect
,_] Visit Host Engineering

,_] Host Forum, FAQs, Downloads. ..
CTRIO WB 2 - DirectLogic PLC
CTRIO WE 2 -EBC + WinPLC
CTRIO WE 2 - PBC
-[HH] cTRIO WE 2 - Offiine

Utilities>ERM Workbench (on left)

4. Launching Do-more! Designer,
then select ERM Workbench
from the Launchpad (on left)

a2 |

-] DBWin32 Logger
DhLoader * Applications:
,é NetEdit 3 % Do-more Designer REElpBwin3z1
] caleulator | visit AutomationDirect & NetEdit3
,h_x" Version |_] visit Host Engineering |J Calculator
{77 DS500.ini
|_]Host Forum, FAQs, Dowrloads... @ Do-more &
CTRIO WE 2 - Do-more PLC @Do-more L
CTRIC WE 2 - Offine Epo-more v
F: ERM warkbench DmDesign
i
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Adding IPX Network Protocol Support on PCs with Windows XP (32 bit

only) or Earlier Operating Systems
You may have already set up your PC with selected networking protocols for Ethernet
communications. If not, you will need to select the protocols now for communication
with the ERM module. We strongly recommend that you include the IPX protocol. The
description below applies to Windows 2000 (Windows 98/NT/XP have slightly different
steps). If you are not familiar with this procedure, you may need to have your Network
Administrator perform this task.

For Windows 2000, go from My Computer on your Windows desktop to Control Panel.
Double click on Network and Dial-up Connections, then double click on the desired
Network Device to see the installed Protocols. If IPX is not listed among the protocols
already loaded, add it now by clicking on the Install button. For Windows XP, go from
Start>Settings>Control Panel. The steps are the same as Windows 2000 from this point.

Add the TCP/IP protocol if it is necessary for your application. The TCP/IP selection will give
you support for the UDP/IP protocol. Also, add the IPX protocol if it is not already active.

Network Properties 21

General | Sharing |

Cannect using:

I B2 Realtek RTLE139(4)-based PCI Fast Ethemnet Adapter

Caomponents checked are used by this cannection:
Vil and Printer Sharing for Microsoft Networks -
V1% MwLink MetBl0S J

T NwLink IPR/SP/MetBI0S Compatible Transport Prator
Tmtemet Fratocal [TCPAR)
4

| »

Install. Whirstall I Froperties |

i~ Description

™ Shawican in taskbar when cannected

0K Cancel |

i NOTE: We strongly recommend you load IPX protocol on your PC for the connection from your
‘E PC to the Ethernet modules. Use UDP/IP in your application, if required,but also add IPX to your
list of active protocols. Having IPX loaded on your PC gives you a backup for troubleshooting
communication problems.
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Running ERM Workbench PLC Wizard

Run ERM Workbench PLC Wizard by launching DirectSOFT or Do-more! Designer, then
select ERM Workbench as mentioned on the previous page. The Wizard allows the ERM
network to be easily and completely configured without having to use the more advanced
ERM Workbench utility.

NOTE: The ERM module and ERM Workbench utility factory default settings are located in
228 Appendix C. These defaults will be applied during the ERM network configuration unless
‘E otherwise changed. Some of the settings can be changed within the ERM PLC Wizard, but all can
be changed using the ERM Workbench utility.

Step 1: Choosing the ERM Network Configuration
Select either Hub or Point-to—point to describe the ERM network system that will be used.
This example assumes that a Hub network is used. Once a selection has been made, click
on the Next button.

ERM Workbench PLC Wizard - Step 1: Describe ERM/Slave Network x|
Ta help cartigure the ERMin a PLC system, please choase the description below that best describes tris ERM/slave
network configuration, then it the Next-> buiion
ERM Network C:
& Hub -ane ERMand one or more slaves are connected to each cther using 2n Ethemet hub.
¢~ Point4o-point -one ERM and exactly one slave are drectly connected to each olher using a cross-over cable
withoust a hub.
I Please, do NOT launch PLC Wizard a starup
ERM Workbench. <Back Cancel

Step 2: Connecting the ERM Workbench PC to the ERM Network
Connect the ERM Workbench PC to the dedicated ERM network hub. If only one slave is
used, connect the PC directly to that slave. Then click on the Next button.

ERM Workbench PLC Wizard - Step 1: Describe ERM/Slave Network x|

To help configure the ERM in a PLC system, please chooss the description below that best describes this ERM/slave
network configuration, then hit the Next-> bution.

(~ Poirtto-point - one ERM and exactly ane slave are directly connected to each other using 2 cross-over cable

ERM Network Cc
£ Hub - one ERM and one or more slaves are connected to each other using an Ethemet hub
without a hub

I~ Please, do NOT launch PLC Wizard & startup

ERM Workbench.. < Back Next > Cancel
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Establishing Communication with the ERM
The following window will be displayed if an ERM module is found on the network. Click on
the Flash Error Light button to confirm that the correct ERM module has been found (the
ERM’s LED will flash for 3 seconds). If the PC is connected directly to the slave in a Point-
to—point network, this window will not be displayed until the PC is connected directly to
the ERM module.

Ethernet Remote Master Found! x|

Ethernet Remote b aster found at the following address:

Ethernet Address: | O0EQ G2 21 B3 BT
with |P Address: 172.30.58. 78

To vizually check which ERM was found, click on the
Flazh Eror Light button below to flash the ERM moduls's
ERROR light off & on for 3 seconds.

EIKl Cancel | Flazh Errar Light

Step 3: Select and Configure the Slaves
The Select and Configure Slaves window will display all of the slaves found on the
dedicated ERM network. The order of how the I/O is mapped into the PLC is based on the
slave order. The ERM to Slave Address Mode selection determines the address mode in
which the ERM module will use to communicate with its slaves. Chapter 2 describes the
ERM / Slave Addressing Modes. Click on the Next button once the slave list is configured.

K [=[olx]
File View Help
DSHamf NP 2@ 2
ERM Workbench PLC Wizard - Step 3: Select and Configure Slaves x|

ERM to Slave fddress Mode " el
: ere s a st of possible daves.

IV @ Ethemetdddess  © Modde D O I Address Vots g wich 16 changs he
order of the slaves. The order

ot Disciste  Discrete  fndog  dnalog of how the 1/0 is mapped into

Input Output Input Output the PLC is based off the slave
# Ethemetéddiess  Points  Points  ‘words  Words an
fl o0Enez 0001 D416 4 2
B T T 6 6 54 “You can configure the address

made used by the ERM when
addressing the skves, You
can also remove any unwanted
slaves from the list

Once you have the slavs st
configured. it the Next buttan

Movelp | MoveDown|  Remove | Resean |
ERM Warkbench... < Back Cancel

NOTE: Due to the manner in which 1/0 is grouped into PLC addresses, it is advisable, for future
expansion purposes, to pad the base with extra I/O. The wizard does not offer the option to add
unused addresses. To pad the addresses, add extra /O before running the wizard. If the padding is
not created, adding an /O module to the base in the future will offset a wide range of I/O in the
PLC's memory map.
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4-6

DirectLOGK: ERM Workbench PLC Wizard - Step 4: Map 1/0 to PLC Memory x|

Do.more! ERM Workbench PLC Wizard - Step 4: Map I/0 to PLC Memory x|

Step 4: Map 1/0 to PLC Memory

Select the starting PLC memory addresses for each of the four 1/0 types: Discrete Inputs,
Discrete Outputs, Analog Inputs and Analog Outputs. Be sure that the selected starting
addresses do not conflict with any local I/O or any memory locations used in the ladder
logic program. Note that the first two words of memory in the Discrete Input table is
reserved for ERM status information and the first word of memory in the Discrete Output
table is reserved for Disable Slave Command bits. For more detailed information on PLC
I/0 mapping, refer to the “PLC Map” section and the “Reserved PLC Memory for ERM”
section. Click on the Next button once the starting PLC addresses have been selected.

Step 5: Download Configuration to ERM

FLC Map

StatingPLC  Ending PLC  Starting ERM Starting Disciete  Ending Discrete
W Addiess Whddiess  Status Addiess 1/0 Address 1/0 Addiess

Disciete el dY
oo u[EHD ] [vamiz [ vaoeiacean) [ vaoste(kam) [ vaoei7 (xaer)

Discrele a
e (L il [vamsts [ vaosiapean) [ vaosisreazy [ vaosie(var)

Enalog A
e V[ s
PLE Memory Map.
Analog v [2100 A
Outputs: EI VeTal

Now select the starting PLC addresses for each of the fowr data ypes - Discrete Inputs, Diserete Outputs,
Analag Inputs and Analog Dutputs. We recommend you uiize the 1 and Y mapped areas of Y memany for
your discrets inputs and discrete outputs.

Mote that the first two wards of % memary in the Discrete Input table is for ERM status infamation. and the first
word of ¥ memary in the Discrete Output table is for Disable Slave Command bits

ERM Workberch < Back Cancel

The following window displays how the slave I/O will be mapped into the PLC memory.

PLC Map

Starting Do-more  Ending PLC  Starting ERM Starting Discrete Ending Discrete
VAddress  Status Address 1/0 Address 1/0 Address

s l:‘:;—reﬂ\ wa | oo [ nene ‘
g‘jﬁ; oo =l [ 4] na [ oo [ nene ‘
woed ow [0 A e PLC Memary Map...
oo o [0 ][ e |

Now select the starting PLC addresses for each of the four data types - Discrete Inpts, Discrete Outputs, Analog Inpts
and Analog Outputs. We recommend you tilize the X and ¥ mapped areas of V memory for your discrete inputs and
discrete oLtputs

Note that the first two words (32 bits) in the Discrete Inpu table s for ERM status information. and the first word (16 bits) in
the Discrete Output table is for Diszble Slave Command bits.

ERM Workbench... < Back Next > Cancel

The network 1/0 modules and I/O points are listed by slave and slot number. This
configuration is written to the ERM by clicking on the “Write to ERM" button. If any
advanced configuration needs to be done, click on the ERM Workbench button. The
modified configuration can then be downloaded from the ERM Workbench utility to the
ERM module.
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ERM Workbench PLC Wizard - Step 5: Configuration Complete - Download or Do Advanced Configura x|

Congratulations! *You have buit your Ethemet Fiemote Master configuration. Below s the lst of all the slaves
and how their 140 s mapped inta PLC memary

If you wish to download the configuration to the ERM immediately, hit the ‘Wiite To ERM button below,

Or, if you wish to do some advanced configuration without dowrloading, select the ERM ‘Waorkbench button,
‘fou can then download the configuration fram the ERM YWarkbench utility

1/0 Module | 140 Points [ PLC Start | PLCErd[ Wbap [ Motes a
Geserved>  Slave Status Bils WE00 K317 VAdid
EFM Status Word M3 K3I V4415
Disable Slave Com Y0 Y37 V40514
Slave 1 HZEBC Ethemet Address|0
Slave 1/5I0t0 16 Discrete Input X340 K357 V40416
Slawe 1/5lot1 B Diserete Output Y3 Y327 VAD515LoldT)
Slave1/5l0t2  4Wword Input V20D V2003 16+t Binary:
2w/ord utput vz vz 16ebit Binary:
Slave 2 TTHEBC hotswaplauta)Ether
Slawe2/SIot1 B Diserete Input %30 XIET VADT7 LolDT)
Skwe2/St2  BDoubleWordOu.. V2102 w2121 bt Binay:
8 Discrete Dutput YI Y3 VAOSIS HIBIS)
Slwe2/SIt3  BDoubleWardlnput V2004 V2023 32:bit Binary: Jﬂ
4| | 3

ERM Wworkbench < Back I ‘wiite To ERM I Cancel |

ERM Workbench Main Configuration Window
The ERM Workbench main configuration window will be displayed once the configuration
is written to the ERM. Refer to the “Write Configuration to ERM" section for a complete
description of the window fields.

In the Slave Status box, the status of a specific slave can be displayed by clicking on the
slave number 1-16. The numbers are highlighted in either normal, green, yellow or red.
Normal (default) indicates that the slave is not configured. Green indicates the ERM is
successfully communicating with that particular slave. Yellow indicates I/O is updating, but
some error exists within the /O of that slave (i.e. module missing 24VDC, unused analog
channels exist, broken transmitter or module missing terminal block, etc.). Red indicates
I/O is not updating and that the ERM is not communicating with that slave. Clicking on the
Slave's Error List button will display the error conditions for that particular slave. The error
codes are then defined under the Error List button.

i ERM Module [00 E0 62 20 13 E2] - ERM Workbench (=] 3]

Fle View Help

D msd Wb S E 2

i~ Ethemnet Remote Master H2-ERM — Ethemet Address‘.l O0EOB22013E2 —|P.| 255 255 255 256 —Module ID:| 0
Interface: [ B3 [+ [5 [ [7 [8 2 Select Slaves.
Last ERM N enor PLE Mode: | Program e 70 [ [z 07 % [ %
Enor 3. Wi 10 ERM...
Click on slave # above Slave 2 - o error =
S to see its Last Enror,
BeadERM Staws | 0T o [ 10:4031
= ClaLostEnorSlave2 | Slave 2sEnorlist |
Detailed ERM Status
140 Module [ 140 Paints [ PLCStat| PLCEnd[WMap | Notes [
<reserved> Slave Status Bits =300 W7 VALATE
ERM Status Ward %320 ST VAMIE
Diisable Slave Comm.. Y300 YHT V40514
Slave 1 H2EEBC Ethernet Address[00 E0 62 00 01 D4] an [P
Slave 14500t 0 15 Discrete Input H340 KT VA4E
Slave 14500t 1 & Discrete Output 320 TIRT VAOS1S,
Slave 14500t 2 4word Input V2000 w2003 16+t Binary:
2word Output V20 vam 16+t Binary:
Slave 2 TIHEEC hatswaplauta)Ethemet Addressl00 E0 62 40 06 34] on P
Slave 2/5l0t 1 & Discrete Input Pl HIT VAT
Slave 2/500t 2 &Double Word Output—— W2102 w2121 32t Binany;
& Discrete Dutput w330 I VAOS1S,
Slave 2/510t 3 8 Double Word Input V2004 w2023 32t Binary:
4DoubleWord Output— ¥2122 w2131 324t Bina:
& Discrete Dutput Y340 YT VAOSTE..
Ready [ | ReadERMStatus: AUTO  [MODIFIED | UM 4
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Running ERM Workbench

First, run the ERM Workbench PLC Wizard by launching DirectSOFT or Do-more! Designer,
then select ERM Workbench as previously mentioned in the Launching ERM Workbench
Section. With the wizard opened, click the ERM Workbench button in the lower left hand
side of the ERM Workbench PLC Wizard window. Checking the “Please do Not Launch PLC
Wizard at startup” box will disable the Wizard from launching, but can be accessed from
View menu>PLC Wizard. The following window will be displayed.

i\ ERM Module [0D ED 62 20 13 E2] - ERM Workbench \ —1al x|

File Wisw Help

EIEE- =R

Ethemet Remale Master| H2ERM  — Ethemel Address| 00ENG22013E2 —IP:| 255 255 255 255 —Module D[ 0
Slave Statu 1. Configure ERM

CFU ‘
Interface:

PLC CRU: [ 260

[T [z ¥ I+ [5 [8 [7 I8 2 Select Slaves

Last ERM
Enor:

Missing configuration  PLC Mode: | Progiam

Click on slave # ahove | Slave 1 - not configured
_— o see its Last Enor
EeadERb Staws |, 5 [10:48:20

[g Mo [ [z [3 [E 75 16

Cleas Last Errr Slave 1 | Slave 1's Enor List |
Detailed EFM Status
140 Moduls [ 170 Prints [_PLCStat [ PLCEnd [ V-Map Notes |
nfa na n/ na nia ERM NOT CONFIGURED
<reserveds Slave Status Bits %300 %37 VAD4TY
ERM Status Ward %320 WA VA4S
Disable Slave Comm 300 ¥IT VD514

Connecting the ERM Workbench PC to the Network Modules
The ERM Workbench PC will need to be connected to the ERM network to configure the
modules as described in this chapter. A hub is not necessary if only one network slave
is used. In this case, the PC will need to be connected directly to the slave module to
configure the slave. Then, the PC will need to be connected directly to the ERM module to

configure the ERM.

Stride
Ethernet
Switch

Do-more! PLC ,\En?glme

DirectlLogic
DL205 I/O with
EBC Module

DirectlLogic
DL405 I/0 with
EBC Module

Terminator 1/O
with EBC Module
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Configure the ERM

NOTE: The ERM module and ERM Workbench utility factory default settings are located in
Appendix C. These defaults will be applied during the ERM network configuration unless otherwise
changed. The default settings can be changed during configuration, module by module, within the
ERM Workbench. Also, the ERM Workbench> View menu>Options allows the default settings to be
change at a system level that will apply to all the new module configurations.

Configuring the ERM
Click on "1. Configure ERM" button. Then select either DirectLOGIC PLC, Do-more! PLC or
WinPLC as the ERM / CPU Interface.

i8]

Fle View Help

DEH s d WS 57

- Ethemet Remote Master | — Ethemet Address | il —Module 1D
. —‘ 1. Configurs ERM

u Slave Statu
CPU: T s e T &
Interface: ‘ ’7 1 2 INGE QU RN CE A ‘ 2. Select Slaves
Loz Eld ERM Configuration =]
wor 3 Wiite to ERM

ERM/CRU Intertace: [Hiot Corfiged |7
Head ERI Directl OGIC PLC
PLE e~ Dormors PLC ﬂl
A T— St tating ERM Stanting Discrets
— i tatus Address [/ AddEss

Diserete

Irputs;
1/0 Module
<reserved: Discrete v e A ,7 ’7
ot j YANET [v300) ] [ 3210

/‘fmal?g ) B i’

Hpu PIC Memar ape.
#nalag v [0 &
Dutputs: EI

Mote that the first 2%WORDs (32 bits) in the Discrete Input table is for ERM status information,
anhd the first WORD (16 bits] in the: Discrete Output table is for Disable Slave Command bits

WAIATE <340 Advanced, |

A4 (300

Ready [ [ [MODIFIED [ [Mum v

ERM Configuration x|

Selecting PLC as Interface = [
. . PLC Map anee
If either PLC is selected, v St 110 Bbere
the PLC Map is enabled. If Bscels v [0 3] [ vaosos wion) [ vensos (x1a0) | Advarces. |
WinPLC is SeleCted, the PLC Discrete v [4050a" 3 | vageos pvion) | vaosos prian)

. . . Outpus:
Map will remain disabled. oo v [

The PLC Map is explained on s PLC Memor Hep
the next page. Clicking on gz P

the PLC Memory Map button . puue savwonc: s2eainie  emuert i
and the first WORD (16 bits) in the Discrete

displays the valid memory b - =
ranges for each PLC that Starting Dia-more Starting ERM Starting Discrete

Status Address 140 Address

supports the ERM module. Drece oz o] [0 4] [ ooooo | obaap | Advncsd
S‘uﬁmf o =] [ & DLYI00 DLY120

Andog ply =

nputs:

" PLE Memory Map...
Analog  pLy 200 A

Oulputs 3’

Nots that the first 2 WORDs (32 bits) in the Discrete Input table is for ERM status information,
and the first WORD [16 bits] in the Discrete Qutput table is for Disable Slave Command bits.
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PLC Map

A starting PLC memory address must be specified for each of the four types of I/O. The

ending address for each 1/O type is determined by the amount of each I/O type used by

the slaves. The PLC Map is divided into 4 separate tables.

1. Discrete Inputs: This is where the ERM will Write all of the slaves’ Discrete Input data.

2. Discrete Outputs: The ERM will Read this from the PLC
and Write it to the slaves Discrete Outputs.

3. Analog Inputs: This is where the ERM will Write all of the slaves’ Analog Input data.

4. Analog Outputs: The ERM will Read this from the PLC
and Write it to the slaves Analog Outputs.

It is recommended to use the V404xx or DLX3xx (X's) for Discrete inputs and V405xx or
DLY3xx (Y's) for Discrete Outputs that are beyond the expansion base 1/0 that exists. The
default addresses are V40414 (X300) and V40514 (Y300) for DirectLOGIC users and DLX300
and DLY300 for Do-more! users. Note that the Starting PLC address and the Starting
Discrete 1/0O Address are not the same. The first two words of memory in the Discrete Input
table is used for ERM/slave status information, and the first word of memory in the Discrete
Output table is for Disable Slave Command bits. Adjust these address as needed, but do
not map over local I/0 used and be sure the PLC supports the alternate addresses selected.

Advanced ERM Configuration

4-10 I

Clicking on the ERM Configuration “Advance” button displays the following window.
Standby Cycle Time is the time the ERM will wait before trying to communicate with a slave

File wizw Help

DSH|mzsf b S| E R

Ethernet Remots Master | — Ethemst Address:| —Module ID:
( —| 1. Configure ERM...
CPU | o | - Slave Statu "

Advanced ERM Configuration x|

~Standby Cycle Tim ~PLE Scan Timeou

=10j x|

i

Time for ERM to wait on the PLC when the PLC is not responding due to
lang PLC scan times.

Time to wiait when a slave is not respanding befare ying to access the
slave again.

IFDISABLED, ERM will try to communicate with slave every 170 cycle. If
ENABLED, ERM will by to commuricate at the given interval

500 ﬂ me

~Unsuppoited Slave Cycle T

Itis tecommended you set this to at least bwice the maximum PLE scan
time for your program. Default (and miriaum) is 100 .

E=

—Advanced ERM Network Setting:

Enable Standby
ol G

Time to wait when a slave is not supported before iying to access the
slawe again. 4 slave is not supported when its 1/ Configurafion does not
tch ERM's of the slave's firamare is obsolete,

Warning] If you are not familar with these Advanced Network seliings,
please leave them disabled, or consult your network administrator.

[~ Enzble ERM's UDP/IP Subnet Mask.

IF DISABLED, ERM will nat communicate with slave untl ERM is pawer
cycled, when suppert will b checked again. |f ENABLED, ERM vil 0 o oo
check slave suppart at given nterval.f slave is then supported. slave wil
be included in EAM s 1/0 cyole

Enable Unsupported A
¥ Glave Cycle Tme | 1000 2’ ms

Ready [ [MODIFIED [ [NUM | 4

that had a communication error. Enabling this feature will help overall 1/0 throughput
when one slave errors in a multi-slave network.
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If the Standby Cycle Time is disabled, the ERM will try to communicate with the slave in
error every /O cycle. If enabled, the ERM will try to communicate with the slave in error at
the given time interval.

PLC Scan Timeout is the time for the ERM to wait on the PLC when the PLC is not
responding due to long PLC scan times. It is recommended to keep it at the default of
100ms or twice the maximum PLC scan time, whichever is greater.

Unsupported Slave Cycle Time is the time the ERM will wait before trying to communicate
with a slave that cannot be supported by the ERM. An unsupported slave may have an 1/0
configuration that does not match the ERM’s or may have obsolete firmware. If disabled,
the ERM will not try to communicate with the unsupported slave again until ERM power is
cycled. If enabled, the ERM will check slave support at the given time interval. If the slave is
then supported, the slave will be included in the ERM’s I/O cycle.

Advanced ERM Network Settings are used to configure the ERM’s UDP/IP subnet mask for
IP address handling. Consult your network administrator if needed.

Select the Slaves

Selecting the Slaves
Select “2. Select Slaves” button. In order to select and configure the slaves, the PC running
ERM Workbench needs to be connected to the specific remote Ethernet slave network.

‘ NOTE: A Think & Do WinPLC can only support one slave per ERM module. A PLC can support up
to sixteen slaves per ERM modules.

A. In the upper left corner of the Select Slaves window is a PC Network
Slaves on protocol group list. Clicking on either the IPX or UDP/IP radio
button determines which protocol is used by the PC running ERM
Workbench to communicate with the remote master and slave modules.
The ERM and its slave modules understand either protocol. Only one of
the protocols needs to be installed on the PC to configure the ERM.

© ©)

\ x|
FIFST, select the skaves 1o be conirolled by this Ethermet Aemote | [SECOND, configure dach slave. Defaukcan | 227 © \
Master. Upto 16 slaves can be added to an ERM's slave fist work, but adiustmehts may be necessary
o Lacal HZEBC
PG Network Slaves o 74— UDPAP CERMsSlavelist ' 00E0E2001311
[

o Module  Modsl Protacel: | 1%

D Number #  Slave Stalus
2 Ethemel Addiess
Addess Mode: | gnEgE2 001311

Bl 00E0520013 11 [Local
ERM Tineout
toSlave: | 2B

Refries: | 1

Failies Before
Standby Mode: | 2

PetFrequency: | 129

10 Count
Dleecte ™ none s
Dsciete [ e points

Hiove Lp Hove Do o

none words

alog
Inpus:
Analog

Show in List fienor Henosl) none words
Outputs:
@ SlavesOry  C ERMsOny  © AllDevices
Configue
Addto
Slave List -> oK [ |

Query IP
Hetwork | NetEdi, |

|

/
®© 6 o
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B. The left column displays the Ethernet Address, IP Address, Module ID and Model
number of the slaves currently on the remote I/O network. If slaves are added or
removed from the network, click on the Query Network button (1) to update the list.

C. The center column displays the ERM's Slave List. To add a slave to the ERM's List,
either double click on a slave in the PC Network Slave List or select the slave and click
on the Add to Slave List button (2). Slaves can also be removed from the ERM’s List
by clicking on the Remove button. One ERM can support up to 16 remote slaves.

D. The right column displays the Slave Configuration of the
slave that is selected in the ERM'’s Slave List.

E. NetEdit can be used to assign IP Addresses to the remote I/O network modules if
required. NetEdit is also required if Module ID is to be software set or if the 405
EBC is used with analog I/0 modules. Normally, a network administrator will assign
an IP Address to each module on the network. Since it is recommended to use a
dedicated remote I/O network, it is not necessary to assign IP Address unless the UDP/
IP protocol must be used. Refer to Chapter 4 “Using NetEdit” for more information.

Configure the Slaves

Setting the Slave’s Parameters
Remote slave parameters (protocol, address mode, timeout, etc.) are set individually for each
slave. To configure a slave, select a specific slave in the ERM's Slave List by either double
clicking on that slave or by clicking on the “Configure” button once the slave is highlighted.

Configure Slave [H2-EBC - 00 E0 62 00 19 11] x|
@ ™ERM o Slave Cammunication Settings—— - Watchdog Sefting
— Enabling the watchdog empowe:s the slave o tun off all outputs when the slave
(e o longer receives any 140 requests fom the Ethemnst Fiemote Master moduls
& |Ps  UDPAP after the specified timeout period. |f enabled, set the watchdog timer to AT
LEAST 10 millseconds
Advanced [P, Disabling the slave's watchdag timer will cause all of the slave's outputs ta remain
in their last state indefiritely.
Network Number: i 7 Enable Slave's W f’
‘Watchdag Timeaut: > M
ERM Pe! Frequen ~
IF the watchdog time is enabled for this slave, the ERM can be enabled to
pet this slave to keep this slave’s watchdog tmer from fing. @
™ Address Mod Make Offline —— il e o Pt o e i M vttt s
 Jaiille 1D the ERM has inconsistent 10 cycle times with other slaves.
% 25 — Setthe pet frequency to AT MOST half the watchdog timeout value, and__—1
/ | AT LEAGT 5 milseconds
" Ethemet Addiess: o A
v Enable Petevery, [125 s
® o e o [ =
€ IF Address:

W W |m_ |7_  Resetve PLE Addresses for Expansion

Since 140 for multiple slaves is packed into PLE memary, use padding ta reserve T
voom for future 140 i this skave. A 1/0 is added or remaved, adust the pad

ERM Timsaut to — values acoordiny sa that PL adcresses of other slaves' /0 can temain at the
A el I S same PLC address.
L = Discrele a| BYTES Andlog |
© Rases [l 4] ipus: |0 = (3 perbyte) o 1° #{ woros

VARY

Consecutive Failues a Dhcrte [~ 4] EVTES fndog [ 4]
et R Dutpuls: =l [Bperbytel  Outputs: £ worps
Ok | SetDefaut|  advanced.. | Cancel |

The following window will display the settings of the selected slave module.

A. The left column, ERM to Slave Communication Settings, determines the
protocol, address mode and the communication Timeout Settings the ERM
module will use to communicate with the specific slave selected.
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B In the Protocol box, click on either the IPX or UDP/IP radio button to select
which protocol the ERM will use to communicate with the selected slave. If
UDP/IP protocol is selected, a valid IP address must be assigned using NetEdit.
The Address Mode determines which network identifier will be used by the
ERM to address the selected slave. IPX protocol supports either Module
ID or Ethernet Address. UDP/IP protocol supports only IP Addressing.

C. ERM Timeout to Slave Response, Retries and Consecutive Failures Before Standby
Mode times can be set for each slave. The default time values should be adequate
for most applications. The values may need to be raised in applications where IP
addressing and routers are used or if a dedicated remote 1/0O network is not used.

D. Enabling the Slave's Watchdog Timeout runs in the slave and allows the slave
to turn off all outputs when the slave no longer receives any I/O requests from
the ERM module. Any outputs that were on at the time of the error will turn
off after the specified time elapses. Set the ERM Pet Frequency runs in the
ERM to reset the watchdog timer in the slave to avoid any nuisance timeouts
due to main CPU inconsistent logic times or ERM 1/O cycle times. Disabling
the slave’'s WatchDog timer will cause all of the outputs to remain in their last
state indefinitely (hold) when the slave no longer receives any 1/0 requests.

E. Reserve PLC Addresses for Expansion allows future I/O modules to be added or
existing modules to be removed from a slave without affecting the PLC addresses of
the other slaves on the network. Pad the discrete inputs and outputs using bytes (8
points per byte) and the analog I/O using words (2 bytes). Padding can only be done
for 1/0 at the end of a slave I/O base, not between two I/O modules on the slave.

F. The Make Offline feature may be useful for users or OEMs that require duplicating
a system several times. For example, a system may consist of 3 EBCs. An offline
ERM configuration allows each additional ERM to be configured without actually
connecting its slaves at configuration time. Once the initial ERM system is
configured, its ERM Workbench configuration file can be used to create another
configuration file with different slave addresses. Checking the Make Offline checkbox
allows slave addresses to be manually set that should be used by the ERM. This does
not change the address in the slave, but changes the ERM configuration to address
a different slave without connecting it on the network when configuring the ERM.

Once the CPU Interface and Slaves have been selected and configured, the network I/O
modules and 1/0 points will be listed by slave and slot number as shown on the next page
(A.). The next step will be to write the configuration to the ERM module

NOTE: If the slave is configured by a Do-more! CPU, it will report back one extra word that
indicates that it is talking to a Do-more! processor. Cycle the power to the slave to place the
slave back into ERM mode.
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Write

414 |

Configuration to ERM

After the ERM CPU interface has been selected and the slaves have been configured, click
on the "3. Write to ERM" button to write the configuration information to the ERM module.
Once the download is complete, the following window can be used to check slave status
and view detailed ERM status, etc.

£i' ERM Module [00 EO 62 20 13 E2] - ERM Workbench ¢ ~=lolx|

File  Wiew Help
MEIEE Y EIDEIEED

* Ethermet Remote Maslev-‘ H2-ERM —Elhemamddvassl O0E0G22013E2 —IP: ‘ 255, 255.255.255 —Module ID:| 0

Pl Slave
@ e | LT SR s W A PYT—
Lact ERM no enor PLE Mode: | Program e [0 07 Az M5 e
Errer 3. Write to ERM
Click on slave # above Slaye 2 no aror
@ ] Tt tosee is Last Enor
———  Hesdbfisiaus | 172304031
Dot £ CloarLast EnorSlave 2 | Slave 25 ErorList |
etaile et
O —®
1/0 Module [ 1/0 Points [ PLCStan [ PLCEnd [ vibap | Notes
<eserveds Slave Staus Bt W00 K37 DAL
| - ERM Status Word ®320 KIS
@ — Dicatle Slave Camm, 300 YT V40514
Slave 1 H2EBC Ethernet AddresslDD E0 62 00 01 D4 on IPX;
Slave 1/5l0t 0 16 Discrete Input K0 WIET V404G
Slave 1/5l0t 1 @ Discrete Dutput Y320 Y327 V40515
Slave 1/5l0t 2 4word Input V2000 2003 16-bit Binay:
2'w/ord Dutput v2100  v2Io 16-bit Binay:
Slave 2 TIHEEC hotswap{auto] Ethemet Addiess{00 EQ 52 40 06 34] on [PX:
Slave 2/Slot 1 8 Discrete Input W3O HIT WA0AIT,
Slave 2/5l0t 2 8Double Word Dulput V2102 V2121 326t Binany;
& Discrete Dutput Y30 Y3 V40515
Slave 2/5l0t 3 & Double Word Input va00e V2023 32+t Binany;
4DoubleWord Dutput Y2122 V2131 32 bit Binay:
& Discrete Output Y0 Y7 V4OSIE
Ready [ | Read ERM Status 1 AUTO [MODIFIED | M | 4

A. Once the CPU Interface and Slaves have been configured using the steps on the
previous pages, the network I/0 modules and 1/O points will be listed by slave
and slot number. This configuration will be written to the ERM by clicking on
the “3. Write to ERM" button. If using a PLC CPU as the interface, note that the
Starting PLC address and the Starting Discrete /O Address are not the same.
The first two words of memory in the Discrete Input table is reserved for ERM/
slave status information, and the first word of memory in the Discrete Output
table is reserved for Disable Slave Command bits. The PLC memory map
information is not displayed if a WinPLC is selected as the CPU interface. See
the following section “"Reserved PLC Memory for ERM" for detailed information.
This table can be sorted by I/O module address or PLC Memory Address.

B. The top row lists the ERM's Ethernet Address, IP Address and Module
ID. It is highly recommended that the Ethernet Address of the modules
is placed on a label near the module in a visible location.

C. The PLC CPU or WinPLC Interface information is listed.

D. In the Slave Status box, the status of a specific slave can be displayed by clicking
on the slave number 1-16. The numbers are highlighted in either normal,
green, yellow or red. Normal (default) indicates that the slave is not configured.
Green indicates the ERM is successfully communicating with that particular
slave. Yellow indicates 1/O is updating, but some error exists within the 1/0 of
that slave (i.e. module missing 24VDC, unused analog channels exist, broken
transmitter or module missing terminal block, etc.). Red indicates 1/0 is not
updating and that the ERM is not communicating with that slave. Clicking on
the Slave’s Error List button will display the error conditions for that particular
slave. The error codes are then defined under the Error List button.
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E. When the CPU Interface is in the Run Mode, the Read ERM Status
button will be highlighted. Each time the button is clicked, the most
current ERM Status information will be read and displayed.

F. Detailed ERM Status provides |
status of the module including Pl oo FLE Mm% e
ERM 1/O Cycle Times. This is the HEmRd 5 o e Solitos
time required for the ERM module e Tt
to update all of its I/O points. g e hversge 0

Cycle Time: [ m ea tus
Remember the ERM and the PLC oo [—— %l

Al Slaves: e of Last Feal
CPU operate asynchronously e Fi |
from one another. The PLC FCMo: | Progian | LDl put e [ - Fas o
CPU scan will be faster than the PLCRead [ PLE Dicee Qupul Btes [ inFUN o
ERM I/O Cycle Time. Thus, the PLCyite [

remote 1/0O points will not be e
updated every PLC CPU scan. ( T

Analog 1/0 Data Registers
Analog I/O Data Registers

Analog input data is mapped channel by channel in decimal format (binary) into
consecutive memory locations when used in an EBC base. Each individual analog I/O
channel has its own 16-bit memory location. For example, an 8 channel analog input
module with starting DirectLOGIC PLC V memory address of V2000 would map the 8
channels of analog data into V2000 — V2007, respectively.

Analog output data needs to be in decimal format (binary). For DirectLOGIC users, be
sure to convert any BCD values to decimal before sending the data to the analog output
registers. Refer to the Analog I/0O Manuals for conversion examples. Terminator analog
I/0 modules consume two (Double) words per channel (32-bits). See Appendix E for
configuring Terminator 1/0 analog output module control byte.

The EBC slave modules automatically maps the analog I/0O data in/out of memory, thus
multiplexing ladder logic or pointer method is not necessary.

5 ERM Module [00 ED 62 20 13 E2] - ERM Workbench (=[S

Fie Yiew Help

DS e d il S(F 2

- Ethemet Remole Master| HZEAM  — Ethemel Addiess| 00 E0B2 2013 E2 —IP:| 255,256,255 255 ~Module|D:| 0
o — o [ e 1. Canfigure ERb
Interlace: [T = 4[5 & [7 [& 2 Select Slaves
Last ERM o ertor PLC Made: | Program o MAT T EE e =
By 3. Wiite to ERM
Ciick on slave # above Slave 2 - na el =
Tt ta see its Last Enror
BeedeRtstzne | 1 of 003
Clear Last Evor Slave 2| Slave ZsEnorList |
Detaled EAM Staus..
10 Module: [ 170 Priints [ PLCStart[ PLCEnd[ Vhap [ Metes
Sreserveds Slave Star Bls W0 K317 d0aTE
ERM Status Ward X3 XIS
Disable Slave Comm YA VAT w0514
Slave 1 H2EBC Ethemet Address[00 EQ 62 00 01 Dé]on IPX; ~
Slave 17510t 0 16 Discrete Input X0 XIT VAD4IE Note: The 205/405 analog 1/0 channels are listed
Slave 1/50at 1 8 Discrete Output Y3 YR V0515 / e _ .
Slave 1/5l0t 2 4'word Input V2000 w2003 16+bit Binary: as 16-bit Binary coﬂsecmlve data registers (1
2 Wword Dulput vZI0 w21 16-bit Binary: word) and the Terminator analog 1/0 channels are
Slave 2 TTHEEC hotswap(auto] Ethemet Address{00 E0 62 40 06 34 . o .
Slave 2/5l0t 1 8 Discrete Input %30 KT VADATT. listed as 32-bit Binary non-consecutive data
Slave 24510t 2 8Doubleword Output Y2102 Y2121 3241 a.na.y,/ € '
8 Discrete Output Y30 Y3 V40515, registers (Double Word)
Slave 2/5/0t 3 8 Double word Input voOm4 vz 325t Binary:
4Doubleword Dutput Y2122 Y2131 325t Binary:
8 Discrete Output Y30 YT V40516, |
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Reserved PLC Memory for ERM

The first two words of memory in the Discrete Input table is used for ERM/slave status
information, and the first word of memory in the Discrete Output table is for Disable Slave
Command bits. The default memory addresses DLX300/X300 and DLY300/Y300 are used in

this example.

Do-more!

Slave Status Bits
MSB LSB

DirectLOGIC
Slave Status Bits

The Slave Status Bits can be monitored V40414

[ITTTTTTTTTTITTITTIT] - o MSB LSB
Slave1%|_x DLXS|ave1 to detect if a slave is in error. Stave 16 CLTTTTTTTTTTITT T Siave 1
3 3 X X
1 0 3 3
7 0 1 0

7 0

ERM Status Word

ERM Status Word

MSB LSB The ERM Status Word contains the MSB V40415 LSE

CCTTTTTTTTTITTITTT ERM deand S Bi h CCITTTITTITTITTITT

DLX DLX DLX error code an tatus Bits (see the X X X X

3 33 3 following description and Error Codes 3 33 3

3 32 2 in Appendix B). Bit 8 indicates that the 3 32 2

7 07 0 ERM is disabling a slave. 7 07 0

\ I\ / \ /\ /
Status Bits  Error Code Status Bits  Error Code

Disable Slave Bits

Disable Slave Bits

MSB LSB The Disable Slave Bits can be used to MSB V40514 LSB
Stave 16 LLTTTTTTTTTTTTTT] Slave 1 gisable a slave from communicating with (LITTITIIT LTI
by by the ERM module. Bit ON = disable that ~ 5'2¢ 16 ¥ M
1 0 specific slave. RESET = re-enable the 1 0
7 0 specific slave. 7 0

ERM Status Word / Reset Slave Code

The ERM Status Word contains the current ERM Error Code in the Least Significant Byte
and the Status Bits in the Most Significant Byte. When using the Slave Disable Bits, the ERM
must recognize the request to disable a slave before attempting to re—enable that slave.
This closed loop feedback is necessary due to the asynchronous scans of the ERM and PLC.
X330 (DLX330 for Do-more!) is the only feedback bit for ALL slave disabling bits (Y300 —
Y317 or DLY300 — DLY317). Either disable multiple slaves all on the same scan or serialize
the disable process by using ladder logic interlocks.

Use the following ladder logic code to manually reset a slave. For example, use this
resetting method when “Hot Swapping” a Terminator /O module on a slave that is set up
to be manually reset using ladder logic. The default for the Terminator EBC is automatic
rescan after "Hot Swapping” and 1/0 module.
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Direct SOFT

€200 co
{ } < PD ) Event occurs to reset Slave 1

co Y300

{ } ( ser ) Disable Slave 1

Y300

Y300 X330 ( Wait to re-enable Slave 1 until X330 (ERM
{ } { } RST ) Disable Request Bit) is ON.

Do-more! Designer

C200

—| ! [
] ¥ PF[E Leaaing Edge One-Shot | £ ent occurs to reset Slave 1
ulse co
co DLY300
= { ser Disable Slave 1
DLY300  DLX330 g DLY300 Wait to re—enable Slave 1 until DLX330 (ERM
L 1 ¥ 4 RST Disable Request Bit) is ON.

Saving ERM Configuration to Disk

The ERM configuration can be saved to disk as an ERM Workbench File (*.erm). The Save
command allows you to specify a name and location for the configuration. See File>Save.

Clear ERM Configuration

The Clear ERM command allows you to clear the existing configuration from an ERM
module. This function is useful when changing the ERM network configuration or
experiencing configuration difficulties. See File>Clear ERM.

Printing/Exporting the ERM Configuration

The ERM Configuration can be printed or exported as a text(.txt) or comma separated
variable(.csv) file. The ERM Configuration can be sorted by either the Slave/Base/Slot
Address or the PLC Memory Address. The ERM/Slave Status can also be included with the
print or export. See File>Print/Export.
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Using NetEdit
The NetEdit Window

NetEdit is a software utility which can be used to set network identifiers (Module ID, or
IP Address) for the network master and slave modules. NetEdit is accessed from the ERM
Workbench “Select Slaves” window or the View>NetEdit Window. NetEdit can also be
used for diagnostic and troubleshooting tasks. This section steps through the individual
segments of the NetEdit utility and the function of each.

loix
File MNetwork View Utls Help
Scan
P | Tepp || o [2)
Ethernet Address |F|B |C |ModueType < |IP Address | m | Name | Description ]
00E0 620019 11 5 = H2EBC 255,255.255.255 25 205EBC 205 Ethernet Base Controller.
00 E0 62 2163 B7 H2-ERM100 (172.30.58.78) 0 HZERM100 Ethernet Remote Master,
4| | |
Module Info | EEC Scttings | ESC Help | General Help |
General Info Ethernet Stal Reset Stats
Fimware Rev: [ 21.388 FWBRev: [ N/ Missed Fi: | 447 Bad Pits: i
BooterRev [ 3032 PLORev: [ N/ T®Col: | 257 Unknown 0
Switch Setting: | 00011001 CPURew: [ W/ Lost Phts: | 38802 T3¢ Errors: 0
Ready [ ][] 4

Ethernet Communication Protocol

" MetEdit 3

In the upper left corner of the NetEdit window,

under the toolbar, you will find there are two File MNetwork View Utls Help
protocol choices: IPX and TCP/IP. The ERM and

its slave modules understand IPX and TCP/ =54 TCRAP Scan E]
IP protocols. Both protocols are permanently i

resident in the firmware of the modules.

When you click on one of these buttons, you are selecting the protocol you want your PC
to use to allow NetEdit to communicate with the master or slave modules. You are not
telling the module which protocol to use. IPX is a Novell standard in widespread use, and
TCP/IP is a popular protocol supported by the configured protocols in your PC.

NOTE: The protocol choice in NetEdit tells your PC which protocol to use to link NetEdit to the
master or slave modules. You are not selecting which protocol the remote I/O network will use.
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Adding IPX Network Protocol Support on PCs with Windows XP (32 bit

only) or Earlier Operating Systems
You may have already set up your PC with selected networking protocols for Ethernet
communications. If not, you will need to select the protocols now for communication
with the ERM module. We strongly recommend that you include the IPX protocol. The
description below applies to Windows 2000 (Windows 98/NT/XP have slightly different
steps). If you are not familiar with this procedure, you may need to have your Network
Administrator perform this task.

For Windows 2000, go from My Computer on your Windows desktop to Control Panel.
Double click on Network and Dial-up Connections, then double click on the desired
Network Device to see the installed Protocols. If IPX is not listed among the protocols
already loaded, add it now by clicking on the Install button. For Windows XP, go from
Start>Settings>Control Panel. The steps are the same as Windows 2000 from this point.

Add the TCP/IP protocol if it is necessary for your application. The TCP/IP selection will give
you support for the UDP/IP protocol. Also, add the IPX protocol if it is not already active.

Network Properties el )

General | Sharing |

Connect Lsing:

I Realtek RTLE139(4]based PCI Fast Ethernet Adapter

T NwLink IPR/5PRNetBIOS Compatible Transport Proto:
Tmtemet Protocol [TCP/P)
4

Companents checked are uzed by this connection:
JE': File and Printer Sharing for Miciosaft Netwarks A
v %™ MwLink NetBl0S J

|

Irstall Urinsial | Pupefies |

"Descnpticu ‘

""" NOTE: We strongly recommend you load IPX protocol on your PC and use it for your module links.
‘ Use TCP/IP in your application, if required, but also add IPX to your list of active protocols. Having
IPX loaded on your PC gives you a backup for troubleshooting communication problems.

Ethernet Address
NetEdit lists the Ethernet Addresses along with Module Type, IP Address, Module ID,
Module Name and Module Description of any modules currently on the remote /O
network.
If modules are added or removed from the network, click on the Scan Network button to
update the list. Notice that the Ethernet Address is the factory-assigned address that is on
the permanent label on the module.
Select a specific module here by clicking on the Ethernet Address or by using the arrow
keys. The selected module is highlighted.

Scan
X | TCRAP || | SEET 2)

Ethernet Address |F |B |C|Module Type # |IP Address | D | Name | Description
O0E0 620019 11 i H2-EBC 255.255.255.255 25 205EBC 205 Ethernet Base Controller,
ODEQ B2 216367 H2-ERM100 (172.30.58.78) 0 H2-ERM100 Ethernet Remote Master.
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Module ID / IP Address / Name / Description

To assign a Module ID, IP Address, Name and Description to the module, double-click on
the specific module to get the General Settings window. In this window you can configure
the available options.

[z lo(x]
File MNetwork View Utls Help
P | Tepp (| Scan o 2)
Ethernet Address | F | B | € |ModueType - |IP Address | D | Name | Description
00E0 6200 19 11 N H2-EBC 255,255.255.255 25 205EBC 205 Ethernet Bas
00EQ 62 216387 H2-ERM 100 (172.30.58.78) 0 H2-ERM100 Ethernet Remote
B
Module ID: |2% E
Name: (S
Description: (205 Ethernet Base Cortroller,
4 |Paddess | 255 - 255 . 255 . 255 »
Module Info | E5C Scttings | EBC Help | General | e
General Info Reset Stats
Fimwiare Rev: [ 21.388 FWBRev: [ N7A MissedFr | D Bad Pits: ]
Buoter Rew: 3032 PLDRev: [ N/ T™Col [0 Unknowin i
Switch Setting: | 00011001 CPURew: [ Wz LastPhts | O T3¢ Exrors i
Ready [T ]

Module IDs must be unique for each module, but they do not have to be in sequence. The
DIP switches must all be set to zero to enable any software to change the Module ID. If not
set to zero then the Module ID will be read only.

The Name field and Description field are optional. The ERM cannot address a slave by
Name or Description.

To set an IP Address, highlight the number in each of the four boxes, and overwrite
the number. Use the twelve-digit number assigned to the module by your network
administrator. If you change the IP Address, do not use the number “255" in any field.
Doing so will cause communication problems.

Clicking the OK button sends all entries to the module’s flash memory.

Module Information

The Module Information box provides the module Version, Booter and Dip switch settings,
as well as, Ethernet Stats and Errors.

Module Info | EBC Settings | EBC Help | General Help |

General Infa Ethernet Stal Reset Stats

Firmware Rev: [ 2.1.388 PWE Rev: [ N/ Missed Fr: 447 BadPkts: | 0
BooterRew [ 3082 PLDRev HiA T®Cok | 257 Unknown: | 0
Switch Setiing: | 00011001 CPU Rew: N Lost Pkis 36802 THEmoe | 0

Ready [ o] 4

The Version and Booter refers to the module’s firmware version. The Dip switch setting
reflects the Module ID.
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— | NOTE: The module information and settings on this page apply to the selected (highlighted)
—— | module. To select a module, click on its Ethernet Address in the Module list.

The Ethernet Stats are statistics related to communication errors. These statistics are
explored in Chapter 6, Maintenance and Troubleshooting.

Click on the Reset Stats button to reset all categories to 0 (zero).

Using NetEdit to Configure the EBC Base

NOTE: The following configuration information applies only to the H4-EBC(—F) and the DL405 /0.

The H2-EBC(-F) and associated DL205 I/O are self-configuring and do not require this additional
step.

EBC Settings Tab

When an EBC is selected from the module list, an EBC Settings tab becomes available, as

seen below.
" MetEdit 3 = Dlﬂ
Fle Network View Utls Help
Scan
L 2 v
Ethernet Address |F|B|C|ModueType - |IP Address | m | Name | Description B
00ED 6240 01DD H4-EBC 10.1.45.43 16 405EBC 405 Ethernet Base Controller.
00 EOD 62 60 46 DD H4-ERM100 10.1.45.40 0 H4-ERM100 Ethernet Remote Master.
Module Info | EBC Settings ‘ EBC Help | General Help |
Canfiguration LIk Firmwar
| General... | ‘ StartWweb based Config... ‘ ‘ Show Baze Contents. . ‘ | Update Firmware.. |
Serial Port... Update Baater...
Ready [ Tl ] 2

The following options are available through this tab:
General Settings: Set Module ID, Name, Description and IP Address

Serial Port: Configure Serial port communication parameters (Note: the serial port is not
compatible with an Hx-ERM as the master)

1/0 Base: Specify installed analog cards

Show Base Contents: Generate, print and save a report of installed modules
Update Firmware: Load new firmware from file

Update Booter: Load a new booter from file

Restore Factory Defaults: Return configurable options to factory defaults.
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General Settings

Assign a module ID: The module ID is only required when the master’'s address mode is set to

Module ID.

Assign a meaningful name and description: These will appear when browsing for convenient

identification.

Assign an IP address: An IP Address is only required when the master’s address mode is set to

IP Address.

Serial Port

Set the desired parameters for the serial port.

Module ID: |15 _|:3'

MName:

D escription:

IP Address: I 10

X

405 Ethemnet Base Contraller.

o]

43 . 43

Cancel |

NOTE: The serial port is not supported when used with an Hx-ERM or Hx-ERM100 master.

I/O Base

56 |

When you click on the I/O Base button, the H4-EBC Base Configuration screen pops up, as
shown below. The H2-EBC and the T1H-EBC are self-configuring and do not require this step.

H4-EBC Base Configuration

The DL405 architecture does not provide
the HA-EBC with enough information ta
distinguish between Dizcrete 1/0 modules
and Analog 140 modules.

To allow for proper operation of your
analog modules, please use the matrix
below to describe the tppe and placement

of any analog modules to the H4-EBC

Left-click the button(z] coresponding to
the location of wour analog module(s] to
cycle through the options, OR right-click.
ot ach button to select from a menu of

ophiohs.
5lo Slet1 | stz [ Skt3 Slot4 | Skts Slot 6 Slot 7
Base Frgsquﬁlan Emply | meeeee | e Empty Empty Emnpty Empty
Baze 1 Empty Ermpty Empty Empty Empty Emipty Empty Empty
Base 2 Empty Ermpty, Empty Empty Empty Empty Ermnpty, Empty
Base 3 Ermpty Ermpty Empty Empty Empty Ermpty Ermpty Empty
Ok Cancel
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The default symbol "---------- " appears on the configuration screen where digital or
analog modules are present. For digital modules, you do not need to make any changes.
The H4-EBC recognizes the digital modules and is self-configuring for the digital modules.

If you are using analog modules, you must let the H4-EBC know that by doing the
following. Click on the slot location where the analog module is located. Continue clicking
on the same slot location until the part number of your analog module appears. You can
also right-click on the slot location to pick the desired module from a list.

H4-EBC Base Configuration ﬂ

The DLA05 architecture does not provide  To allow for proper operation of pour Left-click the button(z] comesponding to
the HA-EBL with enough information to analog modules, please use the matrix the location of pour analog module(s] to
distinguish between Discrete [/0 modules  below to describe the type and placement  cycle through the optionz, OR right-click
and Analog /0 modules. of any analog modules ta the H4-EBC. on each button to select fram a menu of
optionz
[ Swto Slot 1 Slot 2 Slt3 [ Sltd [ Sht5 Slot 6 Slat 7
F4-082D0
Base 0 08T HMn Empty | e | e | Empty | Empty Empty Ernpty
Reset
Baze 1 Empty Empty Empty ripty Empty Empty
D4-04AD Standard Notation
Baze 2 Empty Empty Empty Pl 32bit Ity Empty Empty
F4-04AD 16-bit
F4-04ADS
Base 3 Ernpt Ernpt Ermnpt it Ermnpt Exrpt
[mlt] [l Bl F408AD or F4-08THM-n [l [ Jmit

F4-08RTD or F4-08THM
F4-08THM Unipalar
——  F4-16AD

D4-020A

F4-04DA

F4-04DA-1or F4-04DA-2
F4-08DA-1

F4-16DA-1

F4-04DAS-n

Once the correct part numbers are chosen for each of your analog modules, click the
OK button to save the configuration into flash memory onboard the module. Leave the
symbol “---------- " wherever you have a digital module.

If you are using a D4-HSC High Speed Counter module, the word “Intelligent” will appear
in gray. The High Speed Counter module is configured automatically and no other action is
required other than clicking on the OK button.

Show Base Contents
Opens a report of the installed modules which can then be printed or saved.

Show Base Contents ﬂ

Base 0 : Slot 0 - Module Type 8A - 8 Channel Temperature Input 1=
8 - Word inputs

Base 0 : Slot 2 - Module Type 82 - 16 Point Discrete Input
16 - Bit inputs

Base 0 : Slot 3 - Module Type C0 - 32 Point Discrete Output
32 - Bit outputs

Prirt Font Close:
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Update Firmware
Use this dialog to update the module’s firmware. Pick the firmware file from disk. Firmware
files may be downloaded from www.HostEng.com.

Update Booter

Use this dialog to update the module’s booter. Pick the booter file from disk. Booter files
may be downloaded from www.HostEng.com.

Restore Factory Defaults

Use this button to reset all user configurable settings to the factory defaults. A warning
dialog will appear to verify this action. Select OK to restore to the defaults.

5_8 I Ethernet Remote Master User Manual, 2nd Edition, Rev. D - H24-ERM-M


https://cdn.automationdirect.com/static/manuals/h24ermm/h24ermm.html

MAINTENANCE AND APTER

TROUBLESHOOTING

In This Chapter...

Isolating a Communication Problem..... . . . 6-2
Troubleshooting Chart . . . certetst ettt s astenns 6-2
ERM Module Diagnostic LEDs . . . . 6-4
Slave Module Diagnostic LEDs . . . . 6-4
Using ERM Workbench for Troubleshooting . . . 6-5
Reserved PLC Memory for ERM . . . . 6-6
Using NetEdit for Troubleshooting 6-8

Diagnosing Network Cable Problems... . . . 6-10




- Chapter 6: Maintenance and Troubleshooting

Isolating a Communication Problem

If you are experiencing a problem communicating with an ERM module or one of

its slaves, the problem can usually be isolated to one of four components of the
communication link:

Ethernet module itself (hardware or firmware)

The setup of the Ethernet module

Cabling or connections

Other external influences, such as electrical noise, heavy communication traffic on
the network or exceeding the power budget

Diagnostic Tools and Techniques
Several available tools and techniques can help you isolate a communication problem:
« The LEDs on the face of the module indicate the status of the link, the module, and
the network communications.
« Replacing the module may determine whether the problem is in the module.
« NetEdit and the ERM Workbench display a list of the active modules on the network
and their protocol and configuration settings.

« Cable testing devices can pinpoint short or open circuits or diagnose attenuation
problems and other cabling problems.

Troubleshooting Chart

The following chart summarizes the different types of communication failures you could
experience. In each case the CPU PWR LED must be on, and you must be attempting to
communicate with the module in question.

— identify the ERM module visually. Do not mistake this user initiated event with a true ERM error

Z: NOTE: The ERM Workbench Utility allows the user to flash the error LED for 3 seconds to help
— condition.

The meaning of the diagnostic LEDs is explained on page 6-4.

Troubleshooting Chart
Legend: [ 1 Off B On MXIFlash

ERM Module LEDs Corrective Action
1. Cycle power on the CPU Interface
LIN:STD g OR LIN:STD g unit. This will clear the ERROR if it
ERROR N ERROR was due to a transient condition.
2. Try another cable that you know works.
Error ON Error Flashing Check pinouts (see page 3-7).

3. Try another port on the hub or another hub.
4. Replace module.
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Troubleshooting Chart (Continued)
Legend: 1 Off Il On KN Flash

ERM Module LEDs Corrective Action
LINKGD [ 1. Try another cable that you know works.
ACT [ Check pinouts (see page 3-7).
ERROR [ 2. Try another port on the hub or another hub.
3. Replace module.
No LEDs
LINKGD 1 1. Try another cable between PC and hub.
ACT [ 2. Try another port on the hub or another hub.
ERROR [] 3. Make sure you have not exceeded the

recommended cable length for your
network cable. The link signal could arrive
with sufficient strength even though
the data transmission does not.

4. Could be related to Windows configuration.
Consult Windows documentation.

Only LINKGD ON

g NOTE: This is also the indication of proper operation! Troubleshoot only if you are failing to
= exchange data.

LINKGD LINKGD BBl 1. Try another cable between PC and hub
ACT OR ACT I or other module and hub.
ERROR [ ERROR L_] 2. Try another port on the hub or another hub.

3. Confirm that ERM module is in a usable slot in the
LINKGD ON LINKGD ON PLC base (see pages 3-2 and 3-3) and that the CPU
ACT Flashing ACT ON Interface and its firmware support the ERM module.
4. 4. Look for errors in the setup of the ERM module
or in the communication program.
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ERM Module Diagnostic LEDs

H2-ERM, H4-ERM H2-ERM100 H4-ERM100
Blinks while module is booting. On
S N/A solid when module is ready. N/A
lLinkeD On when module has established communications with the connected Ethernet device,
typically a switch.
ACTIVE Indicates network activity. May appear solid ON during heavy traffic.
lerrOR Lr}?écra;??hznlzigt&rrﬁéé%tla; See Indicates an error from a network device or a fatal internal
Note 1 : error of the ERM module. See Note 2.
100MBIT N/A On solid when linked at 100Mbps.

NOTE 1: The ERROR LED on H2-ERM or H4-ERM modules indicates a fatal internal error. Cycle
power to clear the error. If the error will not clear, replace the module.

NOTE 2: The ERROR LED on H2-ERM100 or H4-ERM 100 modules indicates that some error is

present. Refer to troubleshooting section of this manual to determine the error. Example errors:

» Cannot communicate with an ECOM(100) or GS-EDRV/(100).

» Hardware installed in a base does not match the hardware configuration.

« An analog module error bit is ON.

* Fatal error. If a fatal error has occurred ERM Workbench and NetEdit are unlikely to successfully
communicate with the ERM. Try cycling power to the ERM. If the error will not clear, replace the

module.

Slave Module Diagnostic LEDs
EBC LEDs

Hx-EBCs LED Diagnostic information is located in the Troubleshooting Guidelines chapter
in the Ethernet Base Controller Manual (H24-EBC-M) and for the TTH-EBC in (TTH-EBC-M)
manual.

Error Indicator
A specific ERM network condition that can cause the EBCs ERROR LED indicator to
illuminate is if the watchdog timer times out. This can result from the slave being
disconnected from the ERM network.
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Using ERM Workbench for Troubleshooting

ERM Workbench can be used for troubleshooting an ERM Ethernet remote I/O system. It
allows you to:

« View slave status and Detailed ERM Statistics.

» See active modules on the network.

« Examine or change the slave module’s configuration settings.

Read from ERM
To view the current configuration in the ERM module, launch ERM Workbench and click on
“Read from ERM" under the File menu or tool bar. The following ERM main configuration
window will be displayed.
The ERM main configuration window lists the ERM's Ethernet Address, IP Address, Module
ID just below the menu to identify the connected ERM. If the fields are blank, select File >
Read From ERM to read a specific ERM'’s configuration.

In the Slave Status box, the status of a specific slave can be displayed by clicking on the

mx
File  View Help
D E|msd b 3 E 2
~Ethemet Remole Master| H2ERM  —Ethemet Address:| 00EDB22013E2 —IF:[ 255,285, 286.266 —ModuleID:[ 0 Pra——
Ineface e ULl ®0 T s E (5 [ 7[5 s o
e E o enor PLeMose: [Posen | | o 7 (7| 7 [ F 5 66
o 3. Wite 1o ERM..
Click on slave # above Slave 2 - no enor =
to see its Last Emor:
Fead EAM Statis Time of g 4031
Jast 1ot
Cleat Last Evr Skve 2 | Slave2sErarliss |
Detaied ERM Status.
1/0 Modue [ 170 Points [ PLC Stan | PLCEnd[Viap | Notes
<reservedr Slave Stelus Bis R0 W37 VADAE
ERM Stalus Word X0 ORI V4GS
Disable Slave Commn VA0 Y37 vaOS1
Slave1 H2EBC Ethernet Addres<{00 EO B2 00 01 D] on [P
Slave 1510t 0 16 Diserete Input XMO X3 V404G
Slave 1500t 1 8 Discrete Dutput Y30 Y3 VAOSIS
Slave 15102 4iord Input Va0 v 165l Binany;
2 ord Dutput V2100 vai 166t Binany-
Slave 2 TIHEBC hotswaplaute] Ethernet Address[00 ED £2 40 06 34] an IFK;
Slave 2510t 1 8 Discrete Input XBO X3 VAONT
Slave 2/5i0t 2 8Dowbletword Duiput V2102 V2121 2.6t Binany:
8 Discrete Dutput Y30 Y3W V4OSIS
Slave 20510t 3 8DowleWordlnput V204 V2023 2.t Bineny:
4Dowbleord Duiput V2122 V2131 32l Binany;
8 Discrele Dutput VM0 YW V405
Ready | Read ERM Status : AUTO  [MODIFIED | [MUM [ 4

slave number 1-16. The numbers are highlighted in either normal, green, yellow or red.
Normal indicates that the slave is not configured. Green indicates the ERM is successfully
communicating with that particular slave. Yellow indicates I/O is being updating, but some
error exists within the I/O of that slave and that there are no I/O module errors in the slave.
Red indicates /O is not being updating or that the ERM is not communicating with that
slave. A description of the error will be listed.

The network I/0 modules and I/O points are listed by slave and slot number. For a PLC,
the first two words of memory in the Discrete Input table is used for ERM/slave status
information, and the first word of memory in the Discrete Output table is for Disable Slave
Command bits. The PLC memory map information is not displayed if a WinPLC is selected
as the CPU interface.
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Reserved PLC Memory for ERM

The first two words of memory in the Discrete Input table is used for ERM/slave status

information, and the first word of memory in the Discrete Output table is for Disable Slave
Command bits. The default memory addresses DLX300/X300 and DLY300/Y300 are used in

this example.

Do-more!

Slave Status Bits

MSB LSB The Slave Status Bits

V40414
Slave16[ [TTTITTTTTTTTT [ ]Slave1 can be monitored to detect if Slave16NlIS[B[ EEEEEEEEEE [L[S]BS|ave1
3 3 a slave is in error. X X
1 0 3 3
7 0 ; g

The ERM Status Word

DirectLOGIC
Slave Status Bits

ERM Status Word

ERM Status Word

contains the ERM error code

MSB LSB and Status Bits (see the MSB V40415 LSB
T TTTTITTITTITTITTT] following description and Error CITTTTITITIITITITI ]
DLX DLX DLX Codes in Appendix B). Bit X XX X
g gg g 8 indicates that the ERM s g g‘g g
7 07 0 disabling a slave. 7 07 0
\ /\ / \ /\ /
Status Bits  Error Code Status Bits  Error Code

The Disable Slave Bits
Disable Slave Bits can be used to disable a slave Disable Slave Bits
MSB LSB from communicating with the MSB

Slave 16 LITTTTTTTTTTTTTT] slave1 ERM module. Bit ON = disable llll[l[l[l[l[[[[l
D;Y D'éY that specific slave. RESET = Slave 16 \af \af
1 0 re-enable the specific slave. 1 0
7 0 7 0

Detailed ERM Statistics

Detailed ERM Statistics provides /O Cycle Times, Total Retries to All Slaves and CPU

Interface information. This information may be helpful when trying to diagnose a remote
1/0 network problem. The maximum I/O Cycle Time is the time for the ERM to 1) read the
remote slave inputs and write the data to the CPU and 2) for the ERM to read the output

data from the CPU and write the data to the remote slaves.

Detailed ERM Statistics [00 E0 62 21 63 B7]

Minirmum 120

PLC
Cycle Time:

CPU Interface; 65535 ms

Maximum 170 0
Cycle Time:

Total Number

of 140 Cyces: 0
Average /0
Cycle Time:

TotalReties to g
Al Slaves:

ms
CPL:

Last ERM Emor i efror

Do-more

ms

PLC Onf
PLE Discrete Input Bytes
PLCMode: | Progra used for ERM Status: |
PLC Read PLC Discrete Dulpul Bytss
Reies 0 usedfor ERM Conirot | *
PLE Wite
Relies 0

o

Fimware Status
’V ERM State: mat:

I” Read ERM Status

x|
Clear Statistics

Fead ER Status

Time of Last Read

13:53:656

Force Automatic

in RUN mode

6-6 I
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Select Slaves Window
The left column displays the Ethernet Address, IP Address, Module ID and Model
number of the modules currently on the remote I/O network. This means you are linking
to the modules from your PC. If you are linking to a module but the ERM is failing to
communicate with the module, you can conclude that:

« The module is working.

« The cabling is satisfactory from the PC to the hub and from the hub to the ERM
module

* The hub is working.

« The problem may be an addressing issue. If the ERM is configured to use IP protocol,
make sure that the IP Address for the ERM and slave is valid and unique. If the ERM
is configured to use IPX protocol, make sure that either the Module ID or Ethernet
Address in the slave is correct and unique.

If the ERM or slave module is not on the list, try clicking on either the IPX or UDP/IP radio
button (Query is automatically done when the protocol in the center column is changed).

Select Slaves x|

i Slave Configuration

FIRST. select the slaves to be controlled by this Ethernet Remote SECOND, configure each slave. Default can

Master, Up to 16 slaves can be added to an ERM's slave list. work, but adjustments map be necessam. . oAl HEERE
PC Network Slaves on ~(" [Fx —f* UDPAP —— ERMsSlavelist———————————— ‘| ODEOB2001371
Module  Model
Ethemet Address ID Mumber Slave Status Protacol 1P

O0EDEZ00197171 2¢ 280,256 25 Ethemnet Address
Addiess Mode! | ogEQE2001911

#

1

2

3 .

ERM Timeout ’—

; to Slave: e

6

7

8

Fietries: ’17
g Sayrias | 5
; e [m
}g Pet Frequency: ’W

10 Count

Discrete hore paints
Inputs:

Discrete

Outputs none points
el naone words
Inputs:
Analog

Duiputs none words

awve Up: Mave Down
Remove Remore Al
Configure.

0K I Cancel |

Confirm that your PC has IPX and TCP/IP protocol loaded.

Make sure the desired network slaves are in the ERM's Slave List. The right column displays
the Slave Configuration of the specific slave that is selected in the ERM's Slave List.

NetEdit can be accessed from this window. NetEdit is a software utility that can be used to
set the Module ID, set an IP Address or configure the 405 EBCs for analog I/0 modules if
necessary. See the following section for details on NetEdit.

Show in List:
’7 * Slaves Only " ERMsOnly &l Devices

Query IP

Add o
Hetwork

Slave List >

NetEdi... |
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Using NetEdit for Troubleshooting

NetEdit is a software utility within ERM Workbench which came with this manual. To review
the procedures for accessing and using NetEdit, see Chapter 5. It allows you to:

+ See active modules on the network.

« Examine and change the modules’ configuration settings.

« See the firmware revision number.

« Review statistical information about communication errors by type.
If you can see the ERM and slave modules on the list in the Module box (described below),
you are linking to the module from your PC. If you are linking to the module but failing to
communicate with the module, you can conclude that:

« The module is working.

« The cabling is satisfactory from the PC to the hub and from the hub to the ERM

module.
« The hub is working.
« The problem is in one of the other components of the communication link.

Select a Module

The Module box shows the Ethernet Addresses of all modules which are currently linked to
the NetEdit utility. If your ERM or slave module is not on this list, try the following:
« Change Protocol selection and

. Ethernet Address | F | B |C |Module Type # | IP Address | D
click on Query Network. See 00E0 6200 19 11 = H2-EBC 255,255, 255,255 25
Change Protocol on the next 00E0 62 216367 H2Z-ERM100 (172.30.58.78) 0
page.

« Confirm that your PC has IPX
or TCP/IP protocol loaded.

« Confirm that the module’s
LINKGD LED is on.

— label on the side of the ERM module. See page 2-4 if you need help locating the label. It is
— recommended to record the module’s Ethernet Address on a label and affix it near the module in
a visible location.

[_ NOTE: The Ethernet Address is permanently assigned at the factory, and it is recorded on a

Module Information

The Module Information box provides the module Version, Booter and Dip switch settings,

as well as, Ethernet Stats and Errors. Verify that all modules of the same type have the same
firmware version.

Module Info | EBC Settings | EBC Help | General Help |
General Info Ethernet Stat: Feset Stats
Firmware Rev: [ 21388 PWE Rev Nt Missed Fr. | 447 BadPktz: | O
Eoater Rew: ,W PLD Rew: Méd Ti Coll: | 257 Unknawn: | 0
Switch Seting: [ 00011001 CPU Rew: Wit LostPkts | 36802 T B | il
Ready [ [nom]| | 4
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Ethernet Stats

If you are able to see the problem module on the list of modules currently active on the
network, you can select the module to see the Ethernet Stats for that module. Select the
module by clicking on the Ethernet Address in the Module box.
To begin a new statistical record, click the Reset Stats button.
The diagnostic information available in the Ethernet Stats box is:
» Missed Frames — frames lost due to unavailability of buffer space.
« TXCollisions — detected when RXD+ and RXD- become active during a data
transmission. Two devices are trying to communicate at the same time.
» Lost Packets — packets that overflow the queue.
« Bad Packets — packets that fit the Ethernet standard but are not in the right format
for the EBC module.
« Unknown Type — a foreign command was received and could not be interpreted. This
will probably happen only during software driver development.
e TXErrors — the Ethernet standard number of retries were attempted for a
transmission.

Change Protocol

If you are experiencing a problem communicating from your

PC to a module that does not appear on the list of active Fle Network View Utls Help
modules, try changing the protocol and clicking on Scan i Seen | 7]

Network. You may be able to link to your module with the
other protocol.

Replacing the ERM / Slave Module

A\

If you set up your original ERM or slave module using NetEdit, you will need to duplicate
the settings in the new module using the same procedure.

WARNING: Your system can be damaged if you install or remove system components
before disconnecting the system power. To minimize the risk of equipment damage,
electrical shock, or personal injury, always disconnect the system power before installing
or removing any system component.
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Diagnosing Network Cable Problems

If you are experiencing communication problems, swapping cables is one of the simplest
diagnostic procedures you can perform. If the network operates correctly with a different
cable, you have isolated and cured the problem. If possible, use a short run of cable to test
the network because problems with longer cable runs can be more difficult to diagnose
and are more often intermittent.

If you are unable to swap cables, verify the proper operation of all other network
components. You probably have a cable problem if you have verified that your:

« ERM module is working correctly.

« ERM module configuration is correct.

* RLL program is correct.

« Hubs are working correctly.

« Windows configuration is correct.

» Network adapter card is the correct type, and it is working correctly.
It is a good maintenance practice to test network cables periodically and maintain a
permanent record of cable characteristics. A number of cable test instruments are available
to test 10/100BaseT and 10BaseFL networks. These instruments will check the electrical or
optical characteristics of your cabling, including:

« Continuity — This is a check to make sure the communication pairs are wired
correctly, and that the wires are continuous from end to end. In the case of fiber
optic network this is a test to be sure light is transmitted from one end of the cable
to the other.

« Attenuation — This refers to the amount of signal loss over the cable segment at the
signal frequency of interest. The 10/100BaseT specification allows for a maximum
signal loss of 11.5 decibels (dB) for the entire link at the signal frequency used by
10Mbps Ethernet. The 10BaseFL specification calls for the optical loss in link segment
to be no greater than 12.5 dB.

+ Crosstalk — Crosstalk occurs when a signal in one pair of wires is electromagnetically
coupled to an adjacent pair. This is critical for 10/100BaseT networks which are
susceptible to noise interference. 10BaseFL networks are virtually immune to noise
interference.

[— NOTE: Any significant difference between the cable characteristics of the transmitter and receiver
— can cause communication errors.

Ethernet devices continually monitor the receive data path for activity as a means of
verifying their link is working correctly. When the network is idle, each network device
(including the ERM module) sends a periodic link test signal to verify that the network is
working. If the link test signal or other network activity is not received periodically, the
LINKGD LED on the ERM module is turned off.
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A-2 I

Specifications

General Specifications

H2-ERM / H2-ERM100 and H4-ERM / H4-ERM100 General Specifications

Module Type

Ethernet I/O Communications Master Module

Quantity of Modules

Defined by CPU, base configuration and power Per Basebudget

Quantity of Slaves per ERM

16 max.

Diagnostics

LEDs, ERM Workbench, NetEdit

Communications

H2-ERM / H4-ERM: 10BaseT Ethernet
H2-ERM100 / H4-ERM100: 10/100BaseT Ethernet

Data Transfer

H2-ERM / H4-ERM: 10 Million bits per second
H2-ERM100 / H4-ERM100: 100 Million bits per second

Extension Port RJ45
Link Good Indicator (LINKGD) Green LED
lActivity Indicator (ACT) Red LED
Error Indicator (ERROR) Red LED

Power Consumption

H2-ERM / H4-ERM: 320mA @ 5VDC (Supplied by DL205/DL405 base)
H2-ERM100 / H4-ERM100: 300mA @ 5VDC (Supplied by DL205/DL405
base)

Operating Temperature

32° to 140° F (0° to 60° C)

Storage Temperature

—4° to 158° F (—20° to 70° C)

Relative Humidity

30% — 95% RH (non-condensing)

Environmental Air No corrosive gases permitted
Networking Protocols UDP/IP, IPX

Supported

Manufacturer Host Automation Products
Link Distance 100 meters (328 feet)

Ethernet Remote Master User Manual, 2nd Edition, Rev. D - H24-ERM-M



https://cdn.automationdirect.com/static/manuals/h24ermm/h24ermm.html

Appendix A: General Specifications.

H2-ERM-F / H4-ERM-F General Specifications

Module Type Ethernet /O Communications Master Module
Quantity of Modules Per Base Defined by CPU, base configuration and power budget
Quantity of Slaves per ERM 16 max.

Diagnostics LEDs, ERM Workbench , NetEdit
Communications 10BaseFL Ethernet (fiber optic)

Data Transfer 10 Million bits per second

Extension Port ST-style fiber optic connector

’(-li'l'ﬁ ‘?(;13;1 Indicator Green LED

lActivity Indicator (ACT) Red LED

Error Indicator (ERROR) Red LED

Power Consumption 450mA @ 5VDC (Supplied by DL205/DL405 base)
Operating Temperature 32° to 140° F (0° to 60° C)

Storage Temperature —4° to 158° F (=20° to 70° C)

Relative Humidity 30% — 95% RH (non-condensing)
Environmental Air No corrosive gases permitted

g’s;)"p”gg‘;’;g Protocols UDP/IP, IPX

Manufacturer Host Automation Products

Link Distance Up to 2,000 meters (2km), 6,560ft (1.2 miles)
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Ethernet Standards

A4 |

Various institutes and committees have been involved in establishing Ethernet data
communication standards. These specification standards assure Ethernet network
compatibility for products from a broad variety of manufacturers.

The ERM module complies with American National Standards Institute (ANSI) and
Institute of Electrical and Electronic Engineers standard ANSI/IEEE 802.3, Carrier Sense
Multiple Access with Collision Detection (CSMA/CD) Access Methods and Physical Layer
Specifications. This standard has been adopted by the International Organization for
Standardization (ISO) as document ISO/IEC 8802-3.

The Electronic Industries Association (EIA) and Telecommunications Industries
Commercial Building Telecommunications Wiring Standard designated EIA/TIA-568A
defines implementation of 10BaseT (twisted pair) and 10BaseF (fiber optics) for Ethernet
communications.

The same two organizations produced EIA/TIA TSB40-Additional Transmission
Specifications for Unshielded Twisted-Pair Connecting Hardware. The purpose of this
document is to specify transmission performance requirements and connecting hardware
requirements.
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.Appendix B: ERM / Slave Diagnostics and Error Codes

ERM Diagnostics

The first two words of memory in the Discrete Input table is used for ERM/slave status
information, and the first word of memory in the Discrete Output table is for Disable Slave
Command bits. The default memory addresses DLX300/X300 and DLY300/Y300 are used in
this example.

Do-more! DirectLOGIC
| Bi . | Bi
- Slave Status Bits . The Slave Status Bits Slave Status Bits
can be monitored to V40414
LTI . . mMSB LSB
Slave 161~ oo detect if a slave is in Slave 16 LLTTTTTTTT T  Slave 1
3 3 error. X X
1 0 3 3
7 0 1 0
7 0
The ERM Status Word
ERM Status Word contains the ERM ERM Status Word
MSB LSB error code and Status MSB V40415 LSB
LITTTTTTITIITITIITITIT] Bits(seethefollowing LITTTTTITITIITITIIITIT]
D':;X %L;( D'éx description and Error ' é( )3%( ?5(
3 32 2 Codes in Appendix B). Bit 3 32 2
\7 (/)\7 ? 8 indicates that the ERM \7 ?\7 C/J
is disabling a slave.
Status Bits  Error Code Status Bits  Error Code
The Disable Slave Bits can
Disable Slave Bits be used to disable a slave Disable Slave Bits
MSB LSB from communicating with MSB V40514 LSB
Slave 16 LIII I T I T I T I I I ]sjave1 the ERM module. Bit ON CCIITIITIIIIITIIT]
DLY DLY = disable that specific Slave 16 Y y Slave
¢ 5 slave. RESET = re-enable N 5
7 0 the specific slave. 7 0

ERM Status Word / Resetting the Slave

B-2 I

The ERM Status Word contains the current ERM Error Code in the Least Significant Byte
and the Status Bits in the Most Significant Byte. Currently, only bit 8 is used in the MSB
designating the ERM is disabling Slave.

When using the Slave Disable Bits, the ERM must recognize the request to disable a slave
before attempting to re-enable that slave. This closed loop feedback is necessary due to
the asynchronous scans of the ERM and PLC. X330 (DirectLOGIC) or DLX330 (Do-more!)

is the only feedback bit for ALL slave disabling bits (DLY300/Y300 — DLY317/Y317). Either
disable multiple slaves all on the same scan or serialize the disable process by using ladder
logic interlocks.

Use the following ladder logic code to manually reset a slave. For example, use this
resetting method when “Hot Swapping” a Terminator 1/0O module on a slave that is set up
to be manually reset using ladder logic. The default for the Terminator EBC is automatic
rescan after “Hot Swapping” an 1/0 module.
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DirectLOGIC Example

Direct SOFT
€200 co
{ } ( PD ) Event occurs to reset Slave 1
co Y300
| | ( ser Disable Slave 1
[
Y300 X330 Y300 Wait to re—enable Slave 1 until X330 (ERM
| | ( Rrst ) Disable Request Bit) is ON.
I I

Do-more

€200 co

{ } < PD ) Event occurs to reset Slave 1
co DLY300

{ } ( ser ) Disable Slave 1

DLY300 DLX330 DLY300 Wait to re—enable Slave 1 until DLX330 (ERM
| ] | ( ret ) Disable Request Bit) is ON.

[ I \
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ERM Status Word Error Codes

B—4|

The following table describes the errors that will be reported to the ERM Status Word.

Egg(:i&oa(:f Description
EO No error.
E3 Configured bit inputs overlap system input bits.
E4 Configured bit outputs overlap system output bits.
E5 More than one device found with same module ID.
E6 More than one device found with same IP address.
E7 ERM could not read slave’s error information — slave not responding.
E8 Device not supported; may be old firmware or configuration error.
E9 Device timed out on a function request after retries.
E13 Gateway address needed, but not specified
E14 Subnet mask needed, but not specified.
E15 Configured module ID’s do not match modules in device.
E16 Number of bit inputs specified in ERM is less than actual in slaves.
E17 Number of bit outputs specified in ERM is less than actual in slaves.
E18 Number of word inputs specified in ERM is less than actual in slaves.
E19 Number of word outputs specified in ERM is less than actual in slaves.
E20 Invalid base definition for this device.
E21 ERM has not been configured
E22 Overflow of internal buffer E22.
E23 Overflow of internal buffer E23.
E24 Overflow of internal buffer E24.
E25 Overflow of internal buffer E25.
E26 Overflow of internal buffer E26.
E27 Configuration error: input words configured not enough.
E28 Configuration error: output words configured not enough.
E221 ERM to CPU backplane error.
E223 PLC family unknown.
E224 ERM to CPU backplane error.
E225 Backplane code error returned from PLC.
E226 General backplane error returned from PLC.
E227 Timeout on PLC backplane error.
E228 ERM to CPU backplane error.
E231 ERM to CPU backplane error.
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Reading ERM Statistics

Reading ERM Statistics using Ladder Logic with DirectLOGIC

The following ladder logic example reads the ERM statistics from the ERM module. 12
words (24 bytes) of statistical data are stored in the ERM’s memory starting at VO (TAO). Use
slave address of 90 when reading ERM statistics. In the example below, the RX instruction
stores the statistical data from the ERM module to V1400 — V1413 in the CPU’s memory.
More information on the RX network instruction can be found in the PLC User Manual. The
ERM module is located in slot 2 of the I/O base in this example. Refer to the Special Relays
Appendix in the PLC User Manual to identify each slot's Module Busy and Comm Error bits.

The format of the ERM'’s statistics is as follows:

PLC Address Description of Statistic Format
Addr + 0 Minimum I/O Scan in milliseconds Word / Decimal
Addr + 1 Maximum I/O Scan in milliseconds Word / Decimal
Addr + 2,3 Total accumulated time in milliseconds DWord / Decimal
Addr + 4,5 Total number of I/O Scans DWord / Decimal
Addr + 6,7 Number of PLC Read Retries DWord / Decimal
Addr + 10,11 Number of PLC Write Retries DWord / Decimal
Addr + 12,13 Number of Slave Retries DWord / Decimal

DirectSOFT

Module Busy Slot2 ~ Comm Error Slot 2
SP124 SP125 C200 LD
| |

T f P K0290

The constant value K0290
specifies the slot number (2)
and to read ERM statistics (90).

LD

K24

The constant value K24
specifies the number of
bytes to be read (12 words).

LDA
0O 1400

Octal address 1400 is
converted to 300 HEX and
loaded into the accumulator.
V1400 is the starting
location for the Master CPU
where the specified data will
be read into.

RX

TAO

VO (TAO) is the starting
location in the ERM where
the specified data will be
read from.

C200

seT )
Module Busy Slot 2
SI‘:’124 ( C200
F ( rot )
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Reading ERM Statistics using Ladder Logic with Do-more!

The following ladder logic example reads the ERM statistics from the ERM module. 12
words (24 bytes) of statistical data are stored in the ERM’s memory starting at VO (TAO).
Use slave address of 90 when reading ERM statistics. In the example below, the DLRX
instruction stores the statistical data from the ERM module to V100 - V111 in the CPU's

B |

memory. More information on the DLRX network instruction can be found in the Do-more!
help file. The ERM module is located in slot 2 of the I/O base in this example. Interlocking is

not required in Do-more!. Turning on C10 will result in one read of the ERM.

PLC Address Description of Statistic Format

lAddr + 0 Minimum I/O Scan in milliseconds Word / Decimal

Addr + 1 Maximum 1/0O Scan in milliseconds Word / Decimal

Addr + 2,3 Total accumulated time in milliseconds DWord / Decimal

Addr + 4,5 Total number of 1/O Scans DWord / Decimal

Addr + 6,7 Number of PLC Read Retries DWord / Decimal

IAddr + 8,9 Number of PLC Write Retries DWord / Decimal

IAddr + 10,11 Number of Slave Retries DWord / Decimal

c10

—] | > DLRX DirectLOGIC Network Read

Network Device @ERM_002
Slave ID 20
From DL VO
Number of Bytes 24
To V100
On Success, Set bit C11
On Error, Set bit c12
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Reading Error Codes from Slaves
Reading Error Codes from Slaves with DirectLOGIC

The following ladder logic example reads the Error Codes from three slaves (1-3). The
slaves’ error data is stored in their memory starting at VO (TAO). Up to 36 words (72 bytes)
of error codes can be read from a slave depending on the number of bases and 1/0
modules (slots) used per slave. In the example below, the RX instruction stores the Error
data read from Slave 1 into V2000 — V2013 and from Slave 2 into V2020 - V2033, etc. in the
CPU’s memory. More information on the RX network instruction can be found in the PLC
User Manual The ERM module is located in slot 2 of the 205 1/0 base in this example. Refer
to the Special Relays Appendix in the PLC User Manual to identify each slot's Module Busy
and Comm Error bits. Refer to the Slave Diagnostic Word Memory Table in this chapter for
a description of the word information read from the slaves. This example reads words VO —
V11 (24 bytes) from the slaves.

Direct SOFT
Module Busy
VC60 KO
{ - } SR C60
Cc77
VX300 | KO ST’124 S\PT
1= I
CG?
[
Slave 1 Module Busy  Comm Error
Error bit Slot 2 Slot 2
X300 C6l SP124 SP125 D The constant value K0201
| | | specifies the ERM slot number (2)
I [ l I K0201 and EBC SLAVE base (1).
D The constant value K24
specifies the number of
K24 bytes to be read (12 words).
Octal address 2000 is converted to 400
LDA HEX and loaded into the accumulator.
0O 2000 V2000 is the starting location for the

Master CPU where the specified data
will be read into.

Continued on next page

RX

TAO

VO (TAO) is the starting
location in the slave module
where the specified data will
be read from.
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B-8

Continued from previous page

Continued from previous page

Direct SOFT
Slave 2 Module Busy ~ Comm Error
Error bit Slot 2 Slot 2
X301 Cc61 SP124 SP125 LD
| || M |
[ [ [ [ K0202
LD
K24
LDA
0 2020
RX
TAO
Slave 3 Module Busy ~ Comm Error
Error bit Slot 2 Slot 2
X302 Cc62 SP124 SP12; LD
| || M |
[ [ [ [ K0203
LD
K24
LDA
0 2040
RX
TAO

The constant value K0202
specifies the slot number (2)
and slave 2.

The constant value K24
specifies the number of
bytes to be read (12 words).

Octal address 2020 is converted to HEX
and loaded into the accumulator. V2020
is the starting location for the Master
CPU where the specified data will be
read into.

VO (TAO) is the starting
location in the slave module
where the specified data will
be read from.

The constant value K0203
specifies the slot number (2)
and slave 3.

The constant value K24
specifies the number of
bytes to be read (12 words).

Octal address 2040 is converted to HEX
and loaded into the accumulator. V2040
is the starting location for the Master
CPU where the specified data will be
read into.

VO (TAO) is the starting
location in the slave module
where the specified data will
be read from.
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Reading Error Codes from Slaves with Do-more!
The following ladder logic example reads the Error Codes from slaves (1-3). The slaves’
error data is stored in their memory starting at VO (TAO). Up to 36 words (72 bytes) of
error codes can be read from a slave depending on the number of bases and 1/0 modules
(slots) used per slave. In the example below, the DLRX instructions read 24 bytes of Error
data from Slave 1 to CPU memory V200 - V211, from Slave 2 to CPU memory V212 - V223
and from Slave 3 to CPU memory V224 — V235. More information on the DLRX network
instruction can be found in the Do-more! help file. The ERM module is located in slot 2 of
the 205 1/O base in this example. Refer to the Slave Diagnostic Word Memory Table on the
following page for a description of the word information read from the slaves. Interlocking
reads to the three slaves is not required. The CPU will manage the reads. Turning on C13
will result in one read of Slave 1, then a read of Slave 2, then a read of Slave 3.

Cc13

—] } > DLRX DirectLOGIC Network Read
Network Device @ERM_002

Slave ID 1

From DL Vo
Number of Bytes 24

To V200

On Success, Set bit C14

On Error, Set bit C15

—> DLRX DirectLOGIC Network Read
Network Device @ERM_002

Slave ID 2

From DL Vo
Number of Bytes 24

To V212

On Success, Set bit C16

On Error, Set bit c17

——|»> DLRX DirectLOGIC Network Read
Network Device @ERM_002

Slave ID 3

From DL Vo
Number of Bytes 24

To V224

On Success, Set bit c18

On Error, Set bit c19
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Slave Diagnostic Word Memory

The following table describes the Word information that is obtained when a slave’s
diagnostic information is read (RX) by the PLC CPU into its memory. Applies to DL205/405
and Terminator EBC modules.

Word Description

V +0 Current slave error code: Bits_ 0-1 By _ .
Type of Error: Bits 12—15: ( Bit 12 SET = 1/O Error Condition;SET = I/O Warning) Bit 13

vV +1 Slave module slot in error (slots 0 — 15).

vV +2 Slave module slot in error (slots 16 — 31).

vV +3 Slave’s Last error code

V +4 Extended error code module in slot 0.

V +5 Extended error code for module in slot 1.

V +6 Extended error code for module in slot 2.

V+7 Extended error code for module in slot 3.

V +8 Extended error code for module in slot 4.

vV +9 Extended error code for module in slot 5.

V +10 Extended error code for module in slot 6.

V+11 Extended error code for module in slot 7.

V+12 Extended error code for module in slot 8 or base 1 slot 0.

V +13 Extended error code for module in slot 9 or base 1 slot 1.

V +14 Extended error code for module in slot 10 or base 1 slot 2.

V +15 Extended error code for module in slot 11 or base 1 slot 3.

V +16 Extended error code for module in slot 12 or base 1 slot 4.

vV +17 Extended error code for module in slot 13 or base 1 slot 5.

V +18 Extended error code for module in slot 14 or base 1 slot 6.

vV +19 Extended error code for module in slot 15 or base 1 slot 7.

V +20 Extended error code for module in slot 16 or base 2 slot 0.

vV +21 Extended error code for module in slot 17 or base 2 slot 1.

V +22 Extended error code for module in slot 18 or base 2 slot 2.

V +23 Extended error code for module in slot 19 or base 2 slot 3.

V +24 Extended error code for module in slot 20 or base 2 slot 4.

V +25 Extended error code for module in slot 21 or base 2 slot 5.

V +26 Extended error code for module in slot 22 or base 2 slot 6.

V +27 Extended error code for module in slot 23 or base 2 slot 7.

V +28 Extended error code for module in slot 24 or base 3 slot 0.

V +29 Extended error code for module in slot 25 or base 3 slot 1.

V +30 Extended error code for module in slot 26 or base 3 slot 2.

Continued on following page
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Continued from previous page

Word Description

V +31 Extended error code for module in slot 27 or base 3 slot 3
V +32 Extended error code for module in slot 28 or base 3 slot 4.
V +33 Extended error code for module in slot 29 or base 3 slot 5.
V +34 Extended error code for module in slot 30 or base 3 slot 6.
V +35 Extended error code for module in slot 31 or base 3 slot 7.
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Current / Last State Slave Error Codes

The following table lists the Current and Last State Slave error codes for Word 0 and Word
3 in the Slave Diagnostic Word Memory Table. Applies to 205/405 and Terminator EBC

modules.
Error Code -
: Description

(Decimal) P
EO No error.
E121 Channel failure.
E122 Unused analog input channels exist.
E139 Broken transmitter on one of the analog input channels (if supported by analog module)
E142 Multiple channels failed.

The module which was in this slot is no longer responding. User has removed a module in a
Terminator I/O slave system.

If Automatic Reset (default) is enabled for this slave, it will reset itself once the replacement
E153 module is inserted.

If Manual Reset is enabled for this slave, the user must 1) SET the slave disable flag for that
slave in the first diagnostic output word, 2) wait for bits 8-15 in second diagnostic input word
to equal 1, then 3)RESET the slave disable flag in the first diagnostic output word.

E154 110 configuration has changed. See E153 for reset methods.

Unused analog input channels exist at channel xx (1-16), where xx = Value —200.(Example:
L E212 indicates unused analog channel exists at channel 12.
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Extended Slave Error Codes

The following table lists the Extended Slave error codes for Words 4-35 in the Slave
Diagnostic Word Memory Table. Applies to DL205/405 and Terminator EBC modules.

Error Code o
: Description
(Decimal) p
Bitwise error where bit 5 is always SET. Look at bit 0 thru bit 4 to get a possible list of
errors. Example 34 decimal = 22 hexadecimal (Bit 5 SET and Bit 1 SET).
BIT | Type of Error
0 Terminal block off
E32-E63 1 External P/S voltage low
2 Fuse blown
3 Bus error
4 Module initialization error (intelligent module)
5 Fault exists in module (this bit is SET if any of the above bits are SET)
E117 Write attempt to an invalid analog channel.
E119 Data not valid. Subnet mask or IP address not allowed // EBC SDK data packet not
constructed properly.
E121 Analog input channel error.
E122 Unused analog input channels exist.
E139 Broken transmitter on one of the analog input channels.
E142 Channel failure.
E146 Communications failure. Hitachi drive on-board relay set.
The module which was in this slot is no longer responding. User has removed a module
in a Terminator I/O slave system. If Automatic Reset is enabled for this slave, it will reset
E153 itself once the replacement module is inserted. If Manual Reset is enabled for this slave,
the user must 1) SET the slave disable flag for that slave in the first diagnostic output
word, 2) wait for bits 12—-15 in second diagnostic input word to equal 1, then 3) RESET
the slave disable flag in the first diagnostic output word.
E154 One or more new modules has been inserted into the base. See E153 for reset methods.
Terminator module status error. One or more of the modules in the TIH-EBC base has
E155 X
an error. For more detail check extended errors
E200- E216 Unused analog input channels exist at channel xx (1-16), where xx = Value -200.
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.Appendix C: ERM and ERM Workbench Default Settings

ERM and ERM Workbench Factory Default Settings

The following factory default settings or values can be changed by using the tools within
the ERM Workbench utility.

Iltem Default

c-2|

Protocol IPX

Address Mode Ethernet Address
ERM Timeout to Slave 25ms

ERM Retries 1

Slave Watchdog 250ms

ERM Pet Slave Watchdog 0 (disabled)

ERM Consecutive Comm Failures to
Slave Before Placing Slave in Standby
Mode

5

Slave Padding 0
. DirectLOGIC: V40414 (X300);
Bit Input Address Do-more: (DLX300)
. DirectLOGIC: V50514 (Y300)
Bit Output Address Do-more!: (DLY300)
DirectLOGIC: V2000
Word Input Address Do-more!: DLV2000
DirectLOGIC: V2100
Word Output Address Do-more!: DLV2100
Standby Cycle Time 500ms
Unsupported Slave Cycle Time 1000ms
PLCScan Timeout 100ms
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In This Appendix...
Mapping ERM Slave 1/0 Points

NOTE: Think & Do software (PC-TD8-USB & PC-TD8-WEB4-USB) has been retired and is no longer
supported. Please consider updating to Do-more software for your project.




= Appendix D: Mapping ERM Slave I/O in a Think & Do WinPLC Slave System

Mapping ERM Slave 1/0 Points

The purpose of this appendix is to identify that the Think & Do ConnectivityCenter tool is
used to configure (map) the ERM remote slave I/O points to Data Items. We recommend
that you are familiar with the "Getting Started” and "Creating a Project” chapters in

the Think & Do Studio Learning Guide before attempting to configure the ERM 1/0 in
ConnectivityCenter.

NOTE: The ERM and its slaves need to be configured using ERM Workbench before using Think &
‘E Do ConnectivityCenter to map the ERM slave /0O points to Data Items.

Launching Connectivity Center Tool
To launch Connectivity Center:

1) Launch Think & Do Studio ProjectCenter from the Windows desktop by clicking on Start
> Programs > Think & Do Studio > ProjectCenter. Or, click on the ProjectCenter icon to
start.

2) Click on the File Menu and either Open your Think & Do Project or select New.
3) Within ProjectCenter select Windows CE — Think & Do WinPLC as the Runtime Target.

4) Then click Tools > ConnectivityCenter to launch ConnectivityCenter. Or, click on the
ConnectivityCenter shortcut in the Project Explorer.

5) Once in ConnectivityCenter click on Configuration > Connect or click on the Connect
toolbar button.

Connecting to the WinPLC Base 1/O

ConnectivityCenter will draw a picture of your WinPLC / ERM 1/O network. Clicking on the
Backplane 1/0 Driver in the Board view window will display the WinPLC I/O base.

I Think & Do $tudio - ConnectivityCenter
> Configuation \iew Drivers Devices Tools Window Help =] x|
Board View MEEE R R EEEE /
AOMHZWINPLC | | — Good -
. I Missing BasesModulf or Any Other Error
— Extra Bass/Modul
. — Duplicate Base gf Hodule Hisnatch
N Backplone 170 WInPLC [sier #0 roc 51 1ot 52 SLot 33 Froc 52
Driver & In |H2 -ERH an 2 Ouc [An 2 Duc 16 Ous
H2—PLC
mm —— | ——
gs | E——
=58

/

L = | —
Clicking on Backplane 4
1/0 displays the _— o
WinPLC I/O
Befresh Grid
Attrihute: I Value | =
!I‘ame AThink & Do WinPLC Backplane 1/0 I e B
= Board Info / Board Status Mapping Module Info Module Status Mapping 1/0 Mapping
For Help, press F1 [ oM [
i Start | 53 Think & Do Studio - Projec. | L Think & Do Studio - Desig | B2 Think & Do Studio - C.. 4 930AM
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Appendix D: Mapping ERM Slave I/O in a Think & Do WinPLC Slave System.

Connecting to the ERM Slave 1/0

Clicking on the Ethernet Remote Master Driver in the Board view window will display the
ERM slave I/O base(s).

ERM Slave 1 I/0 Base

I Think & Do Studio - ConnectivityCenter
>4 Configuration View Diivers Devices Tools Window Help MEIES|

40MHZWINPLC

Board View

Backplane 170 Ethernet [sior 50 siot #1 s1er #2 Blot 43 Slot #4
Drives Basz=  |is ou s In e our
Control- e am
ler

=1~ am
H2-EBC L] -

Slave-1

= ] I 1| =—— |=——

e

Clicking on Ethernet ol |
Remote Master Driver Befesh 67

displays the ERM iﬂ‘" Tt ! Yale | ) ’:4

slave 1/0 bases

|~ Board Info /" Board Status Mapping /. Madue Infa Module Status Mapping _/_1/0 Mapping

For Help, press F1 i
2 Start | £33 Think & Do Studio - Projec. | & Thirk & Do Studio - Desig. | E& Think & Do Studio - C... 2 343aM

ERM Slave 2 I/0O Base

I Think & Do Studio - ConnectivityCenter
> Configuration View Drivers Devices Tools Window Help NETES|

Scroll down to
view next slave

Backplans 170
Driver

Ethernst [slos #0 3105 41 5100 42 sros 43 3105 44
Base o 16 15 o

Control-
ler

H2-EBC

Slave-2

| |
4 | _>l_I
Refresh Grid

[ thihute: [ Value | =
ERM I 1 =
1 [+

| Board Info /" Boad Status Mapping 7 ModukeInfo_/_Modle Status Mapping _/_1/0 Mapping
For Help,press F1 [0 [NouM
iR Start | |53 Think & Do Studio - Proieo.. | & Think & Do Studio -Desig... [ Think & Do Studie - C__ 2 3454M

Mapping I/O Points to Data Items

This procedure is discussed in detail in the “Creating a Project” chapter in the Think & Do
Studio Learning Guide. This will map your real world 1/0 to Data Items.
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- Appendix E: Configuring Terminator I/O Modules Analog Output Modules
Analog Output Module Control Byte

Terminator I/O analog voltage and current output and combination analog modules
require configuring via the module control byte. Analog input modules do not require
configuration. The DirectLOGIC example below shows an ERM network Terminator 1/0
slave with a discrete input module in slot 1, an analog voltage output module in slot 2 and
a combination analog current module in slot 3. Note that the module control bytes are
automatically mapped to the "Y” data type registers. The bits within the module control
byte are used to enable or disable the analog outputs, select bipolar or unipolar output
and select the voltage or current output range. For Do-more! applications, the control bits
are mapped to DLY addresses, an example is shown below.

DirectLOGIC
File View Help k

SEIEE T I OEN=E

- Ethemet Remote Masler-( HZERM —ElhamatAddress{ ODEDE22013E2 —IF |255.255 265,255 —Module ID:| D

1. Configure ERM

R PLE chu: [ 260 Slave Sratu
Interface Bl [z [3 [+ [5 [6 [7 [8 2 Geloct Slaves..
LastERM no ermor PLC Mode: | Program [8 [0 [ [z [3 [& [ [ =

Error: 3. Write to ERM...

Click on slave # above
to see its Last Error:

Slave 1 - no emor

Clear Last Ermor Slave 1 | {"Clave 1's Emor List I

Time of
last read.

Head EFH Status
Detailed ERM Status

I 1/0 Points
Slave Status Bits

10:16:30

Module Control Byte for
each analog output module y

O Hodule [_PLCStat| PLCEnd[ VMap [ Mates
300

A3T v40414

EFRM Status Word NI MIT WIS
zable Slave Comm.. Y300 TAT 4014
T1F-08DA-2 Slave 1 y hotswap(auto].Ethernet Adchess[00 E 0 62 40 05 34] on I
Slave 175001 WD RM7 VMG LelDT)
Slave 14500t 2 100 1 32:bit Binary;
T1F-8AD4DA-1 [ 320 TI7 WA0E15 Lo |
T s 1503 T iy 32t Binary;
120 il 32-bit Binary;
@ Disorete Output | 30 Y337 WAD516 Hilg15] |

Do-more

Elle View Help
DER axA P S| E 2]

i~ Ethemet Remote Mastsl-IHZ—EHM‘\[I[I — Ethemet Address{ ODENE22183C4 —IF | 10. .43 2 —ModulelD:| 0
CPU

Slave Statu

1. Configurs ERM

: : VA
e = o | i I alE) Al s 2] 2 Select Slaves.
Last ERM i emtar PLE Mode: | Program 9 @ [ @ G mE e S
Control Bytes Eror

Click on slave # above

are mapped to
DLY addresses in <
Do-more! applications

Read ERM Stalus
\\ Detailed ERM Status...

Time of

last read. 10500

to see its Last Eror:

Clear Last Errar Slave 1 |

Slave 1 - no enor

Slave 1's Error List I

<reserved: DLx300 D37
DLx220 DLx337
T1 F 08DA 2 DLv300 oLyatz?
- - Slawve 1 hotswap|auta]Ether...

T Slave 1/5ot 1 DLY2O00 D12l -bit Binary;
T1F-8AD4DA-1 |oLvazo  plvazr

Slave 1/5lot 2 8 Double Word Input DOVA00 DLV “bit Binary;

4 Double Word Output OLG2040 D204 “bit Binary;
8 Discrete Output |DLY33U DLY337

Ready | Read ERM Status : AUTO | MODIFIED y

N
1/0 Module™N SN 140 Points

| PLC Stant |

PLC End [ V-Map

| Motes |

e-2 |

Ethernet Remote Master User Manual, 2nd Edition, Rev. D - H24-ERM-M



https://cdn.automationdirect.com/static/manuals/h24ermm/h24ermm.html

Appendix E: Configuring Terminator 1/O Modules Analog Output Modules

The table below defines the bits of an analog module control byte. Example “Y" bit
addresses are listed for the analog module control bytes from the ERM network example
on the previous page, along with their equivalent Do-more! addresses. The module control
byte addresses will vary depending on the location of the analog module in the system, the
number of slaves, the amount of output modules used in an ERM network and the starting
discrete output address that is user specified. ERM Workbench will list the appropriate
control byte for any Terminator analog module that requires configuration.

Module Control Byte of 8 and 16-Channel Analog Output Modules and

Analog Combination Modules
. - Example Bit Addresses for |[Example Bit Addresses for|
G A T1F-08DA-2 T1F-8AD4DA-1
Outputs Enable
, - DL: Y320 DL: Y330
Bit 0 0 =All outputs OFF Do-more!: DLY320 Do-more!: DLY330
1 = All outputs Enabled
Unipolar / Bipolar
. B DL: Y321 DL: Y331
Bit 1 0 = Unipolar selected Do-more!: DLY321 Do-more!: DLY331
1 = Bipolar selected
5V /10V Range
. _ DL: Y322 DL: Y332
Bit 2 0=25Vrange Do-more!: DLY322 Do-more!: DLY332
1=10V range
0-20 mA/4-20 mA Range
, - DL: Y323 DL: Y333
Bit 3 0=0-20 mArange Do-more!: DLY323 Do-more!: DLY333
1=4-20 mArange
Bit 4-7 Reserved for system use - -

The following example ladder logic code configures the analog output and combination
analog modules used in the previous examples. The T1F-08DA-2 is configured for outputs
enabled with 10V bipolar range. The T1F-8AD4DA-1 is configured for outputs enabled with
4-20mA unipolar range. The RST instruction can be used to reset the bits, if necessary.

DirectSOFT
Configure T1F-08DA-2
SPO Y320
{ } ( SET ) First scan enables the module’s outputs
Y321
4< SET ) Select bipolar range
Y322
4< SET ) Select 10 V range
Configure TIF-8AD4DA-1
SPO Y330
{ }— ( SET ) First scan enables the module’s outputs
Y333

4<SET>

Ethernet Remote Master User Manual, 2nd Edition, Rev. D - H24-ERM-M I E_3

Select 4-20mA range



https://cdn.automationdirect.com/static/manuals/h24ermm/h24ermm.html

- Appendix E: Configuring Terminator I/O Modules Analog Output Modules

Do-more! Designer

Configure T1F-08DA-2 on the first scan
$FirstScan
STO DLY320
|} { sET )
DLY321
——( SET )
DLY322
——( sET )
Configure T1F-8AD4DA-1 on the first scan
$FirstScan
STO DLY330
|} { SET )
DLY333
—( sET )
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- Appendix F: H2-EBC(100) Analog Module Addressing

H2-EBC(100) Analog Module Addressing - H2/4-
ERM(100)

F=2 |

When using an ERM to EBC configuration, the analog module data in the H2-EBC(100) base
is mapped to V-memory or Discrete I/O. Certain Diagnostics Data is not automatically
mapped. If needed, the Diagnostics Data can be accessed as described in H24-ERM-M
Appendix B.

The ERM Workbench software will tell you what the mapping is for each I/O module in the
H2-EBC(100) base. Once you have configured the H2-ERM(100) or H4-ERM(100) using ERM

5 ERM Module [00 EO 62 60 0D 29] - ERM Workbench =10l x|

Fle WView Help

D w2 S E 2
i~ Ethemet Remate Master‘l H4-ERM *ElhernetAddress'{ ODEDE2E00D 29 *\P" 192,168, 0.147 —Module ID:| 47
1. Configure EAM.

e o o [T Slave Stalu
Intertace: 2 3 e s e 7] e 2. Select Slaves
LastERM e PLCHode [ Pogem | (-4 [y (7 (12 (13 (14 (5 [15

Ermor:

3. Wfrite: to ERM...
Click on slave & above | Slave 1 - Madule eror; ;I
to zee itz Last Enor,
PRead ERM Stalus Time of 4 ea12

Jast read _
Clear Last Erar Slave 1 | [}
Detailed ERM Status..
1/ Moduls [ 10 Paints [ PLCStan | PLCEnd] Wibap | Motes |
<reserveds Slawe Status Bits 300 HITF wand1d
ERM Status Wword 320 337 w4045
Disable Slave Comm. r300 YT W40E14
Slave 1 HZEBC100 Ethermet Address[00 EQ 62 00 27 C9] on IFX;
Slave 1/5kt 0 4 %word Input w2000 w2003 TE-bit Binary:
Slave 1/5lat 1 8'word Input Wanod Y2013 16-bit Binary:
8'word Output V2100 Ya1o7 16-bit Binary;
Slave 1/5lot 2 8'word Input w2014 va0z3 16-bit Binary;
Slave 1/50t 3 4'w/ord Input w2024 V2027 TE-bit Binary:
Slave 1750t 4 16 Discrete Output 320 YIIF V40515
Slave 1/5lot 5 4'word Input w2030 Y2033 16-bit Binary;
2'word Qutput w2110 vail 16-bit Binary;
Slave 1/50t & 4'w/ord Input V2034 V2037 TE-bit Binary:
Slave 1750kt 7 4%/ord Input Y2040 2043 TE-bit Binary:
Ready [ | ReadERM Status : AUTO  [MODIFIED | [MUM [SCRL 2

Workbench you will get a screen similar to the following:

For the example above, the I/O configuration for Slave 1 is:
« Slot 0 = F2-04THM
e Slot 1 = F2-8AD4DA-1
« Slot 2 = F2-08AD-1
« Slot 3 = F2-04RTD
e Slot4 =D2-12TR
» Slot5 = F2-4AD2DA
« Slot 6 = F2-04AD-2
e Slot 7 = F2-04AD-1
Use the addresses shown in the ERM Workbench along with the following table to access
the analog I/0O with your ERM master.

For example, to configure the input resolution of the F2-8AD4DA-1 module located in
Slot 1 of the system, the data provided above along with the table below would show that
V memory location V2104 is required. Also, to read the current temperature detected by
Channel 3 of the RTD module in Slot 3, V. memory location V2026 is required.

Ethernet Remote Master User Manual, 2nd Edition, Rev. D - H24-ERM-M



https://cdn.automationdirect.com/static/manuals/h24ermm/h24ermm.html

Appendix F: H2-EBC(100) Analog Module Addressing.

H2-EBC(100) Analog Module Addressing - H2-ERM(100)

Part Number Channel Data Ltz %c;rtrggurat:on Diagnostics Data*

Input Words: No Broken Transmitter Detection

Word 1 = Ch1 If No 24VDC or No Terminal Block:
g:g::g:; gj Word 2 = Ch2 None + All channels = 0 counts

Word 3 = Ch3  ‘Error’ = 121**

Word 4 = Ch4 + ‘Other’ = Cycles 1 thru 3**

Input Words: Channels with broken transmitter:

Word 1= Ch1 + Channel=0 counts

Word 2 = Ch2 * ‘Error’ =121**

Word 3 = Ch3 + ‘I/O Module Status Word 1" = Channel
F2-08AD-1 Word 4 = Ch4 None Number**

Word 5 = Ch5 If No 24VDC or No Terminal Block:

Word 6 = Ch6 + All channels = 0 counts

Word 7 = Ch7 * ‘Error =121**

Word 8 = Ch8 + ‘Other’ = Cycles 1 thru 7***

Input Words:

Word 1 = Ch1

Word 2 = Ch2 No Broken Transmitter Detection

Word 3 = Ch3 If No 24VDC or No Terminal Block:
F2-08AD-2 Word 4 = Ch4 None « All channels = 0 counts

Word 5 = Ch5 « ‘Error’ =121*

Word 6 = Ch6 + ‘Other’ = Cycles 1 thru 7***

Word 7 = Ch7

Word 8 = Ch8

Input Words:

Word 1 - Chi No Broken Transmitter Detection

Word 2 = Ch2 8 )

Word 3 = Ch3 If No 24VDC or No Terminal Block:
F2-4AD2DA Word 4 = Cha None + All channels = 0 counts

Output Words: ) :Error’y=_121** .

Word 1 = Ch1 + ‘Other’ = Cycles 1 thru 3

Word 2 = Ch2

Input Words:

Word 1= Ch1

Word 2 = Ch2 Channels with broken transmitter:

Word 3 = Ch3 + Channel=0 counts

Word 4 = Ch4 Output Words: * ‘Error’ = 142**

Word 5 = Ch5 Word 5 = Input Resolution + ‘I/O Module Status Word 1" = Bit

Word 6 = Ch6 Word 6 = N/A On for Each Channel with Broken
F2-8AD4DA-1 Word 7 = Ch7 Word 7 = Track and Hold Transmitter™

Word 8 = Ch8 Word 8 = Not Used If No 24VDC or No Terminal Block:

Output Words: « All channels = 0 counts

Word 1 = Ch1 * ‘Error’ =142**

Word 2 = Ch2 + ‘Other’ = OXFF***

Word 3 = Ch3

Word 4 = Ch4

* Diagnostics Data is not automatically mapped. If needed, the Diagnostics Data can be accessed via ERM Workbench or ladder as
described in H24-ERM-M Appendix B.

** See Extended Slave Error Codes in Appendix B for further details.

*** ‘Other’ is a field accessible only in ERM Workbench by clicking the button: Slave N’s Error List. This field cannot be read
programmatically.
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- Appendix F: H2-EBC(100) Analog Module Addressing

H2-EBC(100) Analog Module Addressing - H2-ERM(100)

Part Number Channel Data glodile %‘;’t'gg uration Diagnostics Data*
Input Words:
Word 1 = Ch1
Word 2 = Ch2
Word 3 = Ch3
Word 4 = Ch4 Output Words: . .
Word 5 = Ch5 Word 5 = Input Resolution I’;‘%E?ﬁggﬁp%%ﬁiﬁ%& r;k.
F2-8AD4DA-2 Word 6 = Ch6 Word 6 = Range Selection + All channels = 0 counts .
Word 7 = Ch7 Word 7 = Track and Hold « ‘Error' =121**
Word 8 = Ch8 Word 8 = Not Used « ‘Other’ = OXFF***
Output Words:
Word 1 = Ch1
Word 2 = Ch2
Word 3 = Ch3
Word 4 = Ch4
Channels with broken transmitter:
+ Channel=0 counts
+ ‘Error’ = 142d**
Input Wgrds: + ‘l/0 Module Status Word 1’ = Bit
F2-04THM oz ant None On for Each Channel with Broken
F2-04RTD Word 3 = Ch3 Transmitter*
Word 4 = Ch4 If No 24VDC or No Terminal Block:
+ All channels = 0 counts
* ‘Error’ =121
+ ‘Other’ = OxOF***
Output Words:
R Word 1 = Ch1 None None
F2-02DA-2(L) Word 2 = Ch2
Output Words:
ig'ggg:g'; Word 1 = Ch1 None None
: : Word 2 = Ch2
Output Words:
Word 1 = Ch1
0
ord 3 =
e Word 4 = Chd None None
Word 5 = Ch5
Word 6 = Ch6
Word 7 = Ch7
Word 8 = Ch8

* Diagnostics Data is not automatically mapped. If needed, the Diagnostics Data can be accessed via ERM Workbench or ladder as
described in H24-ERM-M Appendix B.

** See Extended Slave Error Codes in Appendix B for further details.

*** ‘Other’ is a field accessible only in ERM Workbench by clicking the button: Slave N’s Error List. This field cannot be read

programmatically.
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Appendix F: H2-EBC(100) Analog Module Addressing.

F2-04RTD Example (Module in Slot 3)
Using the 'ERM Workbench' dialog below and the 'H2-EBC(100) Analog Module
Addressing - H2-ERM(100)’ chart above, we can find the addresses that contain channel
data for the F2-04RTD module in Slot 3. Diagnostics Data is not automatically mapped. If
needed, the Diagnostics Data can be accessed via ERM Workbench or ladder as described

in H24-ERM-M Appendix B.

7' ERM Module [00 E0 62 20 64 DO] - ERM Workbench

Fie View Help

=100 x|

DS E|wzd b & E 2

- Ethernet Remote Master | H2ERM  — Ethemet Addiess:| 00ED622064D0 1P 10. 1.4 5 —ModuleID:| O - -
U S o Slave Statu L A o
Interface: [T P2 & [ 5 [6 [7 80 2. Select Slaves
Last ERM o eror PLC Mode: | Progiam o] [ [ el e 5 6 —I*
Erar 3 Write tn ERM
Click o slave & abowe | Slave 1 - Module enor; =
to see its Last Enar:
e EA Stetus Time of [ 55.00
last read:
- Clear Last Enor Slave 1 | Slava T EnorLis |
Detailed ERM Status. ..
1/0 Module [ 120 Paints [ PLCStat] PLCEnd[YMap [ Motes I
<reserved: Slave Status Bits »300 HKHT w4044
ERM Status Word %320 X3 VA0S
Disable Slave Comm. 300 W37 W406T4
Slave 1 H2-EBC100 Ethemet Address[00 ...
Slave 1/5i0t 0 4Word Input V2000 V2003 16-bit Binary;
Slawve 1/5lat 1 16 Discrete Input #3340 ®357  WA0416
Slave 1/5l0t 2 & Discrete Outpul ¥320 Y327 WAOGIE
Slave 1/Slat 2 4'ward Input V2004 Y2007 16-bit Binary:
Slave 1/5lat 4 8Word Input V2010 w207 16+bit Binary:
Ready [ [ Read ERM Status : AUTO  |MODIFIED | %
Input Channel Address Error Words
Channel 1 V2004
V2 The Slave Diagnostic Word for slot 3 would be
Channel 2 005 ) X
mapped to V + 7 (the eighth address in your
ch /3 V2006 chosen V-memory range). The H24-ERM-M manual
anic Appendix B contains an example.
Channel 4 V2007
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